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Preface
This guide provides the installation procedures and the information used with EditShare’s EFS Control User
Interface (UI).

Conventions
The following conventions are used throughout this guide:

Bold text in procedures indicates icons, buttons, links, or menu items that you click on.

Italic text indicates variables.

Monospace text indicates text displayed on screen.

Technical Support
For questions not addressed in our documentation, contact EditShare Technical Support. Have the exact
version number of your EditShare implementation, as well as your support agreement number.

EditShare strongly recommends that you purchase a support agreement for your system.

Please contact EditShare Technical Support at the following URL:

http://www.editshare.com/support

Information about new features and bug fixes are available in the EditShare ReadMe for your server’s
version, the EditShare update web site http://updates.editshare.com/ or your server’s Status Page.

You can also find sales and support contact information at http://www.editshare.com/support.

EditShare strongly recommends that you purchase a support agreement; if you do not have a support
agreement, a per-incident rate is available for problems not covered by warranty.

Information about new features and bug fixes are available in the EditShare ReadMe for your server’s
version, available at http://updates.editshare.com/ or your server’s Status Page.
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Chapter 1: Introduction
This document introduces you to the purpose and functions of your EditShare system, explains the
concepts you will need to understand to use it effectively, and describes workflow procedures. The
Editor’s Guide is designed not only for editors but also administrators, technical support specialists, and
anyone else who uses the EditShare system.

The Editor’s Guide starts by providing a high-level overview of what EditShare is and how you use it to
store and share media files and metadata. It provides specific instructions for connecting to EditShare
on Windows and macOS computers, explains the concept of Media Spaces and how EditShare
facilitates sharing media, discusses the other Spaces EditShare provides, and presents instructions for
sharing files. Information specifically for users of individual Non-Linear Editing (NLE) applications is also
included.

EditShare Virus Protection Statement
With increasing frequency we are being asked about virus protection for EditShare systems. In a nutshell,
here is the EditShare position on the need for virus protection on EditShare Shared Storage Solutions.

NOTE:  It is important to note that all EditShare server products are Linux-based (except Geevs).

Linux Facts
Linux systems have historically not faced the same levels of virus infections and threats as has been
experienced with other operating systems. Some claim that the reason for this is that the number of
vulnerable Linux servers is so small that virus ‘developers’ simply look for bigger targets.

Also, there are other factors that also explain why Linux systems are relatively invulnerable to viruses:

● Applications running on EditShare run as normal users not root users. Thus it is very difficult for
a virus introduced by one user to spontaneously jump to another user.

● EditShare products rely heavily on open source code and the open source code community
puts a lot more eyes on the system source code and its vulnerabilities.

● Linux enables users to implement highly diverse end-user configurations.
● System software is frequently updated.
● Software generally installed from trusted repositories.
● Based upon empirical evidence from some 3000+ EditShare installations, our position is that as

long as EditShare Installation Recommendations are followed, EditShare servers are not
vulnerable to malware and/or viruses.
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EditShare Installation Recommendations
EditShare requires that all Editshare servers hosted by a network with internet connectivity be installed
behind a regularly-updated firewall. This is intended to thwart virus infections, malware and attacks
originating from the outside world.

EditShare discourages the installation of any third party applications, such as email servers, on
EditShare servers. This is intended to prevent virus infections from email attachments and other
common virus infection sources.

EditShare recommends that all client devices also be installed behind a firewall and utilize
regularly-updated antivirus scanning software. This is intended to prevent virus infections from sources
such as email attachments, internet downloads of media files and other project materials. However,
EditShare recommends that antivirus scanning software be disabled while normal production and
playout operations are active. Otherwise, antivirus is likely to impact the performance of real-time
activities. This will make it impossible for EditShare to guarantee the performance of its products.

In addition, we make a specific recommendation about Windows Defender. Our experience has told us
that Windows Defender is difficult to turn off and sometimes difficult to limit to specific times or
specific processes. If you opt to use Windows Defender, make sure that automatic scanning is turned
off except during off-hour maintenance periods.

By implementing these recommendations, it is unlikely that EditShare servers will suffer a virus attack.

Impact of Antivirus Protection on EditShare Servers
It is technically possible to implement an antivirus scanning feature for EditShare servers. But, in order
for any implementation to be effective, it would need to scan every file written to (and potentially read
from) EditShare storage. The process of scanning files for virus signatures would limit write (and
potentially read) speeds in unpredictable ways and EditShare would no longer be able to provide
guaranteed stream counts or bandwidth metrics.

Running virus scanning on EditShare servers during off hours, to minimize the impact to workflows, is
not a viable solution because any virus introduced into a shared environment can potentially be spread
to other users/clients during the inactive virus scanning period. Obviously, only virus protection
running on the client devices would be effective in preventing further infection.

Summary
For the reasons outlined above, EditShare’s position is that the installation recommendations we make
for our servers are the most effective way to prevent virus infection and does so without impacting the
performance of our systems.
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Chapter 2: Overview
This chapter introduces you to the high-level concepts you need to understand in order to use
EditShare’s products.

What is EditShare?
Your EditShare system is a Network Attached Storage (NAS) server or group of servers with hardware
and software that are highly optimized for video editing. It provides a networked file system for both
media files and metadata that enables multiple editors to collaborate on projects. Editors can work
with the same media files, bins, and sequences in a controlled fashion that limits the opportunities for
editors to accidentally or maliciously interfere with each others' work.

EditShare Hardware
The EditShare system is a high-performance, high-bandwidth, powerful storage system. Its complexity
is hidden from the editors and other people using the system. You simply see a group of remote drives
that appear to your systems just like other local hard drives built into your computer or connected via
FireWire, USB, or Thunderbolt. A simple utility, EditShare Connect, allows you to connect to the drives
you need and perform sharing operations.

EditShare Spaces
The purpose of EditShare is to provide Spaces in which you can store data. You can access these
Spaces in a similar manner as physical hard drives connected to your computer, even though they are
actually located on a storage array on the EditShare server and accessed over your network. These
kinds of network Spaces are referred to by a variety of names. Your workstation’s operating system
might refer to them as network drives, shares, folders, volumes, or directories. They all mean
essentially the same thing: places on the network where you can store data.

Once you have logged in to EditShare, you will see the Spaces available to you in EditShare Connect as
well as in Windows Explorer or the macOS Finder. You can access several types of Spaces, each with its
own purpose. (Most organizations use only a few types of Spaces, not all of them.)

Type of
Space

Space
Subtype

Description For Additional
Information

Media Space Stores media files. Different types of
Media Spaces use different strategies to
manage the way NLE systems can access
the data and to protect media from
accidental modification or deletion as
shown below. Access to each Media
Space is restricted to specific users.

See Chapter 4: Media
Spaces.

Avid Style Avid Style Sharing provides bin-locking
and media sharing that works the same
way as Avid's Unity and Isis storage.

See Introduction to Avid
Style and Avid MXF Media
Spaces and EditShare Avid
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Style Sharing.

Avid MXF For Avid editing applications only. Each
editor owns one or more folders. The
media in each editor’s folders are
read-only to other editors. Each editor
can modify or delete the files in his or
her own folders, but not in another
user’s folders. The Administrator can
protect files to prevent deletion, even by
the original creator. Maintenance Mode
allows one user to organize or delete
any files, even those the user doesn’t
own.

See Avid MXF Media
Spaces in Detail.

Managed For all NLEs except Avid. Editors can
modify or delete their own files, but not
another user’s files. The Administrator
can protect files to prevent deletion,
even by the original creator.
Maintenance Mode allows one user to
organize or delete any files.

See Managed Media
Spaces.

Unmanaged Any editor can modify or delete any file.
No protection is provided against
accidental or malicious modification or
deletion.

See Unmanaged Media
Spaces.

Universal Universal Media Spaces are only for use
with EditShare Flow. For more
information, see your Flow
documentation.

Private Files
Space

Small private space for each user to
store project files. Media files not
permitted.

See Private Files Spaces.

File Exchange
Space

Small shared space for users to store
project files. Separate spaces exist for
users connecting through SMB and AFP,
files are not owned by any specific user,
and files cannot be protected. Media
files are not permitted.

See File Exchange Spaces.

Shared
Project Space

Space to store shared projects. Media
files are not permitted.

See Sharing Avid Projects
Using Avid Shared Project
Spaces.
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NOTE: EditShare does NOT recommend using Traditional Spaces, a legacy option that may be available when
upgrading from older versions of EditShare, and you can no longer create new non-Avid Traditional Spaces.
EditShare recommends creating and using Avid MXF or Avid Style spaces for Avid media, Avid Style or Avid Shared
Project Spaces for Avid project files, or Managed and Unmanaged Spaces for non-Avid media and project files. If
you are using Traditional Spaces on your site, see Appendix A: Traditional Media Spaces.

EditShare Administrator
The EditShare Administrator takes responsibility for the daily operation and configuration of an
EditShare server. In some organizations this is a system administrator or technical support specialist,
while in others it is an editor who takes on this additional role. The EditShare Administrator has the
following responsibilities:

● Set up and configure the EditShare server and network (or help the reseller to do so). See the
relevant chapters of the EditShare Administrator’s Guide.

● Create user accounts on the EditShare system and provide editors with the usernames and
passwords they are to use. Some users might be granted limited administrative capabilities. For
example, a lead editor on a particular project might be allowed to manage the media for that
project. See the relevant chapters of the EditShare Administrator’s Guide.

● Create Media Spaces for storing media files, typically one or more Media Spaces for each
project. See the relevant chapters of the EditShare Administrator’s Guide.

● Oversee management of media on the EditShare server by ensuring that media is protected
when it should be and coordinating times when media is organized or deleted.

● Provide a first line of support for other editors in the organization, helping them to learn the
EditShare system and attempting to resolve problems locally before calling your dealer or
EditShare Technical Support.

EditShare Workflows
Different organizations naturally use different workflows. The following is a general overview of how you
use the EditShare system to store media files and projects and share them among multiple editors. You
might find that the system at your organization is not exactly like this, but it should be similar.

When you begin working, you run EditShare Connect on your workstation to log in to EditShare, being
careful to confirm that no one else is logged in at the same time with the same username. This gives
you access to all the Spaces that have been created by the Administrator. (For more information about
each type of media space, see Chapter 4: Media Spaces.) You mount the Spaces you intend to work
with through EditShare Connect and start your NLE.

13



Avid Editors
Shared Project and Media Workflow

As an Avid editor, in all likelihood you are working either with Avid Style Media Spaces (where you can
put both projects and media) or with a combination of Avid Shared Project Spaces and Avid MXF Media
Spaces. Whichever spaces your EditShare Administrator has chosen, you can share both media and
projects with your colleagues and have a complete collaborative workflow.

After you start EditShare Connect and mount the spaces you intend to use, you can start Avid as usual
(see Chapter 3: Getting Started).

When you’re ready to capture media, you tell Avid to store its captured media in an Avid MXF or Avid
Style Media Space instead of on a local hard drive, and you log it into a bin where you have Read/Write
access.

In Avid Style Media Spaces, which function like Avid Unity and ISIS workspaces, the first person who
opens a bin gets Read/Write access and all subsequent users are restricted to Read Only access until
the bin is closed by that first user. Then the next user to open it gets Read/Write Access. While you have
a bin locked, other users can still open that bin and see the contents as you last saved it. They can
easily copy clips and sequences out of your locked bin and use them in their own sequences that they
are saving in a bin where they have Read/Write access. In general, all media in Avid Style spaces can
always be deleted by any user who has overall write access to the space. If you delete clips in a bin that
is Read Only to you at the moment, you do not delete the master clips from the bin. You can, however,
delete the actual media files from the space.

The rules governing EditShare’s Avid Shared Project Spaces are a little different. In each shared Avid
Project, every user gets their own User Folder. While a bin resides in your own User Folder, only you
have Read/Write access to it. Other users can see the contents of your bin as you last saved it, open the
clips and sequences from there, play them, and edit them into their own sequences, which they can
save in their own bins. They can also copy your entire sequence and save a copy in their own bin.
However, other users cannot modify your bin, even when you do not have the bin open.

EditShare provides a way to pass the ownership of bins from one user to another, but generally you
have to give up control of your bin before another user can take control. In a similar manner, when you
capture or render media into an Avid MXF Media Space, generally the files you create can only be
deleted by you, unless the Administrator puts the space into Maintenance Mode and gives control to
another user, or unless the Administrator protects your files so that even you do not have the ability to
delete them.

While the two systems differ in their security rules, they both achieve the same end result, allowing a
group of editors to work collaboratively sharing the same media and project files.

For detailed information, see the following topics:

● Introduction to Avid Style and Avid MXF Media Spaces
● Spaces for Storing and Sharing Avid Projects
● Avid Style Workflow
● Chapter 7: Using Avid Applications
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Adobe Premiere Pro Editors
Shared Projects Workflow

As an Adobe Premiere Pro editor, you are very likely working with an Adobe Premiere Pro Shared
Project, or with a lockable project space. Once you have started EditShare Connect and mounted the
Media and Project Spaces you intend to use, you can start your editing application as usual, along with
the EditShare Project Browser (see Chapter 3: Getting Started).

When you’re ready to capture media, you create a new Adobe Premiere Pro Project file in the project
structure in the Shared Project Space. Other users can open your project and see the clips you capture
as soon as you save the project. They can edit your clips into their sequences, but they cannot modify
or delete them – only you can do that. You can also look at the clips other users have captured, and the
sequences they’ve cut, by looking in the project files stored in their user folders. To work on another
user’s sequence, you make a copy of the sequence in one of your own project files first, then edit it
there – you cannot modify anything in another user's project file, just as no one else can modify
anything in your project files.

The EditShare Administrator (or a designated user) might protect the media you have captured, to
guard against accidentally deleting it after other editors have cut it into their sequences.

For more information, see Project Sharing with Non-Avid NLEs.

Individual Projects Workflow
As an editor using an NLE system such as Adobe Premiere Pro, you keep your own copy of the project
on your hard drive or in your Private Files Space on the EditShare server.

When you’re ready to capture media, you tell your NLE to store its captured media in a Managed Media
Space or an Unmanaged Media Space instead of on a local hard drive. You can rename, move, modify, or
delete the files you captured, but no one else can. Other users can see your captured media immediately
and import it into their project—or, to help keep media organized, you might export a copy of the bin you
captured into and save it in the Shared Project Files folder on the EditShare server for other users to
import. They can then incorporate the captured media into their sequences.

The EditShare Administrator (or a designated user) might protect the media you’ve captured, to guard
against accidentally deleting it after other editors have cut it into their sequences.

For more information, see Chapter 10: Using Adobe Premiere Pro.

Metadata and Media Files
Non-linear editing projects primarily use two types of files: media files and metadata files. In order to
use EditShare safely and effectively , you need to understand the differences between them. These
differences require you to use somewhat different strategies for sharing them.

Media Files
Media files are your captured or rendered video and audio files. The essential fact about media files is
that, once they have been captured, they are ordinarily not modified. When you edit with an NLE, the
software does not modify existing media files – it simply refers to sections of specific files.
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Metadata Files
Metadata files are everything media files are not. Depending on your NLE, metadata might include
project files, bins, sequences, and settings files. Metadata files are frequently changed during the
course of editing.

Other Files
Some files are not clearly media or metadata. For example, still images, title graphics, text files, and
credit rolls are media but might be modified outside of the NLE. You should generally treat such files as
if they were metadata.

Differences Between Sharing Metadata and Sharing Media Files
Most editing applications such as Avid Media Composer, Final Cut Pro, and Adobe Premiere Pro have
no built-in capability to referee what happens if multiple users open and try to modify the same
metadata file at once.

For example, if Editor A makes a change in a sequence and Editor B has the same sequence file open,
when Editor B saves the sequence, he overwrites all the changes that had been made by Editor A.

Similarly, if Editor B adds two clips to a bin, and Editor C adds two different clips to the same bin, the
last editor to save the bin is the one whose data is retained. The other editor’s data might get lost.

Because of such issues, it is generally not safe to simultaneously open the same metadata files from
more than one workstation if it is possible that one or both users might wish to modify the files.

Media files are typically not modified once they are created, so it is generally safe for multiple editors to
open and view the same media files at once. But project files (metadata) are modified almost every
time they are opened – even as simple an action as moving the play head on a clip usually results in a
change to a project file. In order to collaborate on a project, each editor must usually work with his or
her own copy of the metadata files.

The EditShare system, however, allows multiple users to share project files in spaces that can be used
with most NLEs, including Avid Media Composer, and Adobe Premiere Pro. If your project is stored and
shared in a Shared Project Space or an Avid Style space, you can safely work with projects, bins, and
sequences that other users are working on. The EditShare system allows multiple users to have safe,
read-only access to project files while ensuring that only one user at a time can write to these files. For
additional information about this feature see Avid Style Media Spaces in Detail and Chapter 7: Using
Avid Applications.

If you do not use EditShare’s project-sharing feature, you can still collaborate on projects by having
each editor work with his or her own copy of the metadata files. Methods for doing this are discussed
in the following chapters.
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Chapter 3: Getting Started
This chapter describes the procedures you follow as an editor to work on projects using EditShare. You
follow these procedures regardless of which NLE you use. Additional information specific to Avid
products, Final Cut Pro, Adobe Premiere Pro, and other NLEs can be found in the chapters for those
systems. These chapters contain many important procedures that you must follow to avoid damaging
your data.

Administrator Responsibilities
Before you use EditShare, your Administrator must:

● Set up the EditShare server.
● Install the EditShare Connect software on your workstation.

The Administrator should also provide you with the following information:

● The IP address of the EditShare Master server. In some environments, different workstations
might use different IP addresses to contact the master server. Always use the proper IP address
for the workstation from which you are connecting.

● A username and password. It is important that no user is ever connected to the EditShare
server twice at the same time – for example, from two different workstations. If you need to
work on more than one workstation at a time, the EditShare Administrator should provide you
with more than one username. In some environments, usernames to log in with might be
allocated for each workstation rather than each editor.

● One or more Media Spaces to use for your projects. If your project uses more than one Media
Space (as most do), be sure to find out how they are to be used. For example, you might be
given one Media Space for capturing media and a separate Media Space for rendered files, or
there might be several Media Spaces into which different types of media should be captured.

For additional information about network protocols, see the EditShare Administrator’s Guide.
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Disabling Windows Defender

CAUTION: If you disable Windows Defender, you must ensure that the device is installed behind
a firewall and utilizes regularly-updated antivirus scanning software in line with the EditShare
Installation Recommendations.

It has been found that Microsoft’s Windows Defender is the cause of a number of issues with the
performance of EditShare Storage. Even when Windows Defender appears to be disabled, it can still be
enabled. The following procedure shows how to completely disable Window Defender:

1. Click the Start button and type ‘windows defender’.
2. Click on ‘Windows Defender’ in the search window.

If a message box opens, stating that Windows defender is turned off, you do not have to do
anything and you ignore the rest of this procedure.

3. Windows Defender opens in the Home screen. If Defender is enabled, it displays a green
Monitor icon and the message ‘Your PC is being monitored and protected’.

4. Click on the Settings tab.
5. Uncheck the ‘Turn on real-time protection’ box.
6. Click Save Changes.
7. Click the Home tab. Confirm that Real-time protection is off. If disabled, Defender displays a red

Monitor icon and the message ‘Real-time protection is turned off.
8. Reboot your computer.
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Logging in with EditShare Connect
EditShare Connect is an application that runs on your Windows or Mac workstation and allows you to
connect to any space on any of your EditShare servers from one simple interface, and (on Windows) to
map it to a drive letter. It then remembers which Media Space, Project Space, or other spaces you are
connected to (and to what drive letters they are mapped) the next time you log in, even from a
different workstation, and automatically reconnects you to the same spaces. For designated users,
EditShare Connect also provides limited access to the management functions of EditShare.

See the EditShare Administrator's Guide for instructions on installing EditShare Connect on editors’
workstations.

WARNING: DO NOT connect to EditShare from more than one workstation at a time with the
same username. This can corrupt your data. If you need to change workstations, always log
out of EditShare on one workstation before you log in on another one.

To log in with EditShare Connect:

1. Determine the IP address of the Master server port to which your workstation is connected.

NOTE: Editors using an HA EFS system must type the IP Address of the Storage Stack. Ask the
Administrator for your system if you are not sure which IP Address to use.

2. In Windows, click the Start button, then select Programs > EditShare > EditShare Connect. On
macOS, open EditShare Connect from the Dock or Applications folder.

3. The Log in to EditShare dialog box opens.

4. Type the IP address, hostname, or DNS name of the EditShare Master Server (or HA Storage
Stack) in the Server text box.

5. (Optional) Select Remember Me for your username and password to be remembered and filled
in automatically the next time you log in. If multiple people use the same account on your
workstation, do not select this option, as it may allow others to log in with your credentials.

6. If you are logging in with an Active Directory account, check the ‘Use Active Directory account’ box.
7. Type your username and password in the text boxes and click Login. You can change your

password, if required, after you log in. See Changing your EditShare Connect Password.
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8. EditShare Connect opens, and displays the EditShare media spaces available to you.

9. If no spaces display, the network may have been configured incorrectly or be trying to use
Jumbo Frames on a network that does not support them. For more information, see the
Network Configuration section of the EditShare Administrator’s Guide.

Resetting your Login Count
If you try to log into EditShare Connect while you are already logged into any other workstations,
EditShare Connect will warn you before you log in.

If you see this message because your account is active on more than one workstation, EditShare
strongly recommends that you click Cancel and log in as a different user.

If you see this message because your workstation crashed, and you are absolutely certain that no other
workstations are logged in as this user, you can click “Clear count and Log in” to reset this count,
prevent this message from appearing again, and continue to log into EditShare Connect.
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Changing your EditShare Connect Password
Users who do not use Active Directory to authenticate can change their EditShare Connect password
from within EditShare Connect. (For more information about Active Directory support, see the
EditShare Administrator’s Guide.) After changing your password, you are logged out of EditShare
Connect and need to log in again.

1. Save all your files and close any editing applications.
2. Log into EditShare Connect and click on the Settings tab.

3. Click the Password Change tab to show the Change Login Password panel.
4. Type your current password in the Old Password text box.
5. Type your new password in the New Password text box, and then type it again in the Confirm

Password text box.
6. Click Change.
7. You are logged out of EditShare Connect.
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Connecting to Spaces
Much of the EditShare Connect window shows you the EditShare Spaces available to you. You can also
click the square toggle at the left side of each Media Space type to collapse spaces of that type, leaving
more room for the other types. For each space, you can also see the total available quota, the total
storage used, and any notes about the space’s status.

Connecting to Spaces on Microsoft Windows
Windows users need to select a drive letter to which the space will be mounted.

1. From the ‘Mount/Unmount’ drop down list for the Media Space you want to mount, select a drive
letter. Make sure the drive letter you select has not been assigned to any other space or device.

2. If the space is mountable with the EFS Native Client, EditShare Connect will use the Native
Client, otherwise it will use SMB.

3. To disconnect from the space, select the blank option from the top of the Mount/ Unmount
drop down list for that space.
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Connecting to Spaces on macOS
When working with an EFS storage system, EditShare Connect provides two options: EFS, and SMB.
EditShare recommends that you select EFS wherever possible. EFS mounts are compatible with SMB
mounts, so you can use them interchangeably.

1. From the ‘Mount/Unmount’ drop down list for the Media Space you want to mount, select EFS
(recommended) or Native SMB.

2. To disconnect from the space, select the blank option from the top of the Mount/ Unmount
drop down list for that space.
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Connecting to Spaces on Linux
NOTE: While macOS and Windows also include native support for NFS, performance is much better when you
use EFS, or if you can’t use EFS, then SMB. If you are working from a macOS or Windows workstation, do not
use NFS to access your EditShare storage.

EditShare allows Linux users to access Media Spaces and Project Spaces via the Network File System
(NFS) protocol. EditShare's NFS support is specifically aimed at Linux users. Although Linux users can
also access EditShare spaces via the CIFS or SMB protocols (using mount.cifs or mount -t smbfs
commands) and although CIFS or SMB might be adequate for occasional copying of data, performance
is far superior when you access EditShare spaces via NFS.

If your EditShare Administrator has allowed you to mount one or more Spaces by NFS, the NFS Export
Tool on the server generates a file called nfs-exports.txt in the SMB File Exchange. This file includes
command line instructions about how to mount the spaces from your Linux workstation, as shown in
the following illustration.
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Managing Connections to Spaces
Disconnecting or Unmounting All Spaces

WARNING: DO NOT mount or unmount media spaces using macOS Finder or Windows
Explorer. If you do, EditShare Connect may not properly notice when spaces are unmounted,
and it might be difficult to remount the drive.

To unmount all currently mounted spaces, do one of the following:

● Select the Spaces tab and then click the ‘Unmount All’ button.

● Close the NLE you are working in and then quit EditShare Connect.

Working with EditShare Spaces
EditShare Connect also provides access to management functions for EditShare Spaces, such as
QuickTime Reference Mode, as well as Limited Administrative capabilities for authorized users.

For more information about QuickTime Reference Mode, see Making QuickTime Movies using
Special-Purpose Usernames.

Hiding macOS Resource Forks
You can hide macOS resource fork files on Windows workstations. The presence of resource forks in Media
and Project Spaces can cause some Windows applications, particularly Avid Media Composer, to hang.

You can hide macOS resource fork files on Windows machines. The presence of resource forks in
Media and Project Spaces has been reported to cause issues for some Windows applications,
particularly for Avid Media Composer where the Avid Phrase Find plug-in can hang if it sees macOS
resource fork files.

It is not necessary to hide resource forks unless you use both Windows and macOS Avid applications at
your site, and only if those applications share the same spaces.

1. Select the Settings tab and then select Preferences.

2. Under Resource Forks, select the ‘Hide resource forks’ radio button.
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Disabling EFS Native Client Mode
If you are using a Windows application that is incompatible with EFS, you can use EditShare Connect to
disable the use of the EFS Native Client.

1. Select the Settings tab and then select Preferences.
2. Scroll down the page and, under EFS, uncheck the ‘Mount using EFS Native Client (when

available)’ box.

3. To re-enable Native Client mode, click the box.

A macOS users can disable Native Client mode by selecting the alternative protocol offered to EFS when
mounting a Media Space.
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Quitting EditShare Connect

WARNING: Forcibly unmounting spaces that are in use by an application can result in data
loss or corruption. Do not use other methods of exiting EditShare Connect, such as the Force
Quit action in macOS. This does not log you out of the server properly and might cause
problems when you or another user try to log in again on that workstation.

When you quit EditShare Connect, all of your Media Spaces, Project Spaces, and other spaces are
disconnected. Other users can then use that workstation to connect to their spaces, and you can safely
log in on another workstation.

To quit EditShare Connect:

1. Click the Quit button at the bottom right of the EditShare Connect interface.
2. If any spaces are in use, you are asked if you want to force them to unmount or to stop logging out.

3. To forcibly unmount any connected spaces, click Force Unmount.

Migrating Media and Projects to EditShare
You can migrate your existing media and projects to EditShare. Before doing so, complete the following:

1. Select projects that are active editing assignments.
2. Organize the media in terms of the project it belongs to. Keep projects separate that are owned

by different clients, or projects covering different subject matter. This facilitates editors
knowing which Media Spaces to mount, which media can be moved or deleted, and where the
media resides.

3. Decide on a schema: post-production houses might create a Media Space for each job, while a
news facility might organize by dates or subject matter, for example, features, interviews,
headlines, and so on.

4. Create the Media Spaces you need.

See the following topic:

● Migrating Avid Media and Projects to EditShare
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Checking the EditShare Server Status
To check the status of the EditShare server status, open EditShare Connect. The server’s status is
displayed at the top right corner of EditShare Connect.

The types of status messages are as follows:

● If the status is Good, the server is functioning normally and is not
reporting any issues.

● If the status is Warning, a temporary or non-critical problem is
affecting the server, reducing performance or preventing certain functions from working. For
instance, there may be a connection error.

Alternatively, a Warning may be reporting a hardware issue, which should be immediately
reported to the Administrator for your EditShare system.

● If the status is “Error,” something is preventing the workstation from
reaching one or more of the EditShare servers. The server may be off, certain services may not
be working, or there may be a network error preventing access.

To see more details about the server status:

1. In EditShare Connect, click on the Status button.

2. A message box opens, displaying further information about the error.
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Troubleshooting EditShare Connect
General Issues
The following table includes possible solutions to common problems you might encounter while using
EditShare Connect.

Issue Possible Solution

Error message when you log in. ● Check the server IP address.
● Make sure the server is running and on the network.
● Check your username and password.
● Make sure that your version of EditShare Connect is at

the same version level as your EditShare server. If in
doubt, download and install a new copy from your
EditShare server’s web page.

● If you are logging in as an Active Directory user, make
sure the domain controller is accessible from your
workstation.

No spaces visible after you log in. ● Make sure the Master server and all Expansion servers or
Storage Nodes are running and on the network.

● Try disabling jumbo frames on your workstation if they
are enabled. If that works, your network might not
properly support jumbo frames.

● You might not be a member of any Media Space.

Settings forgotten when you log out. Make sure you have selected the correct profile.

Cannot exit the application. Click the Quit button at the bottom right of the EditShare
Connect window.

Drives stay connected after you log
out.

● Make sure no application (including your editing
application) has a project or document on the drive open
when you quit.

● Log out by clicking the Quit button at the bottom right of
the EditShare Connect window.

● Drives connected outside EditShare Connect are not
disconnected by EditShare Connect.

Error message when you connect to
spaces.

● You cannot connect to a space to which you are already
connected.

● (Windows only) You might have another space or drive
mapped to the selected letter. Try a different letter.

● The space might have been removed or your access
might have been removed.

● You should not be logged into a server as two different
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users at the same time. Check to see if you might have a
drive mounted as a different user. Logging out of or
rebooting your workstation might help.

Some spaces are not shown. ● Spaces to which you do not have access are not shown.
● Spaces on servers that are not operating or not on the

network are not shown.
● You might be logged in as a different user.

Checking for Updates
If the EditShare servers have recently been updated, the check mark next to the status indicator may
change. This denotes that an update to EditShare Connect is available.

A message box may also display when you log in, stating that an update is available.

Always make sure EditShare Connect is updated after your administrator updates the server. Some
features may not work if the EditShare Connect client is out of date.

To install the update, refer to the EditShare Administrator's Guide.
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Chapter 4: Media Spaces
Media Spaces are virtual volumes on the EditShare server where your media files are stored and
shared. You need to create at least one Media Space for storing media files.

Using Multiple Media Spaces
Your EditShare Administrator is responsible for creating Media Spaces of the proper types for your
organization, specifying which users can access each Media Space, and deciding whether to set a quota
on each Media Space to limit the total size of files that can be stored in that Space.

The best way to manage media is to give each new project its own Media Space, with the same name as
the project. This way you know exactly where the media is stored that belongs to a particular project,
making it easy to manage – and eventually delete – the media from one project without affecting the
media from another project. Knowing that all the media in a particular Media Space can be deleted
vastly simplifies media management. In some cases, you might even prefer to use multiple Media
Spaces for an individual project, to help keep your media files better organized or to optimize the use
of your EditShare storage.

Consider the following:

● EditShare highly recommends having separate Media Spaces for rendered files and for original media.

● For an ongoing TV program like a news show, you might have Media Spaces for each week of
shooting, so old media can easily be deleted without affecting newer work.

● To more evenly distribute media across the storage devices, you might have separate Media
Spaces for different cameras. You might capture footage from Camera 1 to one Media Space, from
Camera 2 to a second, and so on.

The EditShare Administrator's Guide has more information about how to set up Media Spaces. As an editor,
make sure you find out from your EditShare Administrator which Media Spaces to use for which purposes.

Controlling Access to Media Spaces
When a Media Space is created, users must be added to the space in order to have access to it. Only users
who have been added to the Media Space can connect to it over the network or see any of the media in it.
The EditShare Administrator (or a user to whom the Administrator has delegated this authority) can add
or remove users to a Media Space at any time.

By default, a user added to a Media Space has full read/write access to the Space. However, the
Administrator (or designated user) can restrict specific users to read-only access to a Media Space. A user
with read-only access to a Media Space cannot capture or render files into it. All other users still have
read/write access to that Media Space, and the user still has read/write access to any other Media Spaces
of which he or she is a member.
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Protecting Media in Media Spaces
Although a Media Space is used just like any shared networked drive, it is much more complex. On a
typical (that is, non-EditShare) networked drive, all users looking at the drive see the same contents,
and any user can add, change, or delete files at any time. Indeed, an EditShare Unmanaged Media
Space works just this way, for those users who want that.

However, this can be problematic in a shared environment. For example, one user might believe a
particular file is unneeded and delete it, unaware that another user still needs it. Worse, some NLEs
(notably Avid) might cause data corruption if multiple editors try to work with the same drive at the
same time.

EditShare Media Spaces, on the other hand, are designed to allow multiple editors to share media
safely. This enables editors to work with the same media at the same time without confusing the NLE
software. It also helps to protect against the possibility of one editor accidentally or maliciously
deleting, modifying, or overwriting media that another user is relying on.

Different types of Media Spaces provide these protections differently. Each type has its own advantages
and disadvantages. To provide this protection, EditShare requires a specific procedure to be followed in
order to delete, modify, or overwrite data in a Media Space.

Types of Media Spaces
EditShare supports several types of Media Spaces, each offering support for specific types of NLEs and a
different method of managing media (and, in some cases, also projects). The types include the following:

● Avid Style spaces (for Avid users only); see Introduction to Avid Style and Avid MXF Media Spaces
and Avid Style Media Spaces in Detail.

● Avid MXF spaces (for Avid users only); see Avid MXF Media Spaces in Detail.
● Managed (for all NLEs except Avid, such as Final Cut Pro or Adobe Premiere Pro); see Managed

Media Spaces.
● Unmanaged (for all NLEs except Avid, as well as non-project metadata and other media or asset

files); see Unmanaged Media Spaces.
● Universal (for use with EditShare FLOW); see your FLOW documentation.

Your Administrator can also make any Media Space public, which provides access to all users. Refer to
the EditShare Administrator’s Guide.

NOTE:  If your server was upgraded from an older version of EditShare, or in very specific legacy Avid workflows,
you may also have access to Traditional Media Spaces. For more information, see Appendix A: Traditional
Media Spaces.
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Introduction to Avid Style and Avid MXF Media
Spaces
If you work with Avid Media Composer or Avid Symphony, as well as older Avid applications such as Avid
NewsCutter, Xpress Pro, and Xpress DV, you can store your media files in either Avid Style or Avid MXF
Media Spaces. In addition, you can store your Avid project files (bins and sequences) in either Avid Style
Media Spaces or Avid Shared Project Spaces (see Spaces for Storing and Sharing Avid Projects for more
information about Avid Project Sharing). Which specific types of spaces you use depends on your
workflow preferences and needs.

While EditShare pioneered the first non-Avid system for sharing media, bins, and sequences (a system that
includes EditShare’s patented Avid MXF Spaces and Shared Avid Project Spaces), EditShare’s Avid Style
sharing provides bin-locking and media sharing that works the same way as Avid's Unity and ISIS storage.

Each type of space and its associated workflow has advantages and disadvantages. For example, the
original EditShare way of sharing bins – in Avid Shared Project Spaces – is much more secure for
schools and organizations, where individual editors want some guarantee that their shared bins and
sequences cannot be modified by others. Similarly, with Avid MXF spaces, media files are controlled by
the user (not the workstation) that created them. Also, rebuilding media database files is easier with
EditShare's Avid MXF spaces compared to Avid Style spaces.

The following illustrations show the structure of EditShare’s Avid MXF spaces and Avid Shared Project spaces.

With Avid MXF spaces, each editor has his or her own view of the Media Space. UserB’s media is stored
in a 1 or 2 folder (and so on). UserB sees UserA’s media in folders called UserA_1 and UserA_2.
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In EditShare’s Avid Shared Project spaces, control over shared bins in an Avid Project, as seen in the
previous illustration, is managed according to the user folder where the bins reside. Bins in UserA’s
folder are Read Only to other users. UserA has read-only access to UserB’s and UserC’s bins. Using Avid
MXF and Shared Avid Project spaces is very effective for collaborative workflows.

However, if you are an Avid editor accustomed to the way Avid Unity and Avid ISIS storage work, with
EditShare's Avid Style sharing you do not need to learn a new way of doing things; you get both Avid
Style bin-locking and the Avid way of managing media files according to the workstation that created
the media. In addition, with Avid Style Spaces, you get a small performance boost that can be important
when you ingest or output sequences with many layers of audio and video tracks.

With Avid Style spaces, media is stored in folders that correspond to the name of the workstation
where the media was created. For example, in the following illustration, three workstations—editbay1,
editbay2, and editbay3—have put media into this Avid Style space.

If you move from one workstation to another, it can be more complicated for you to maintain absolute
control over your media with Avid Style spaces because control over the media database files stays
with the workstations.

For Avid projects stored in Avid Style Media Spaces, there is no locking of bins by users as seen in the
following illustration. Any bin can be opened Read-Write by the first user who opens it. This is represented in
the Avid application by a green lock icon on the bin. Any subsequent users have only Read access, which is
represented by a red lock icon.

With EditShare, you are not forced into using only one approach. For example, you can use Avid MXF
Media Spaces for your media and Avid Style Media Spaces for your bins, or equally viable, you can use
Avid Style Spaces for your media and Shared Avid Project Spaces for your bins and sequences.

For important information on where to save your Avid projects, see Backing up Avid Projects.
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Backing up Avid Projects
EditShare servers are configured by default to automatically backup your shared Avid projects daily at 4
a.m. server time.  The backup includes all Avid projects located in any Shared Avid Project Space, as well
as all Avid projects stored in any Avid Style Space.

For the backup feature to work with Avid Style spaces, you must save your Avid projects inside the Avid
Projects directory that EditShare makes whenever a new Avid Style space is created. Avid projects
stored outside this directory are not backed up. The following screenshots illustrate where you must
save your Avid projects inside Avid Style spaces so that they will get backed up each night.
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Avid Style Media Spaces in Detail
The following table describes features of Avid Style Media Spaces.

Feature Description

Supported NLE Avid v5.x and later. You can use Avid Style Spaces for either MXF or OMF video
media, and MXF (PCM), AIF, or WAVE audio.

NOTE:  You can use Avid Media Composer v2.8 and later.

Network Protocol Windows: EFS or SMB; macOS: EFS or SMB

Access Control Users must be added to the Media Space to have access. However, unlike Avid
MXF Spaces, media is written into directories that correspond with the name of
the computer that is connecting to the space, not written into user directories.

All media is read-write to all users who have read-write access to the space.

Any user can delete media from any media folder in the Space.

The same holds true for the bins in any projects that are stored in the Space.

User Operations You must enable EditShare Avid support in your EditShare Connect client to use
Avid Style Spaces. If EditShare Avid support is not enabled, you cannot capture
media into the Space

You can switch support on and off by selecting or deselecting the EditShare
Avid option.

Contents OMFI MediaFiles/Creating (folder present but unwritable to all users)

OMFI Media Files/YourComputerName (folder where your workstation writes
OMF files when running Avid)

OMFI Media Files/OtherComputerNames (folders where other workstations write
OMF files when running Avid)

Avid MediaFiles/MXF/1 (folder present but unwritable to all users)

Avid MediaFiles/MXF/YourComputerName.1 (folder where your workstation
writes MXF files when running Avid)

Avid MediaFiles/MXF/YourComputerName.# (additional folder where your
workstation writes MXF files when running Avid)

Avid MediaFiles/MXF/OtherComputerNames.# (folders where other workstations
write MXF files when running Avid)

AvidProjects/ (folder where you should store Avid projects if you want Avid
Style locking)
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Although media and projects can be stored in a single Avid Style Media Space, EditShare recommends
creating a dedicated Avid Style Media Space just for Avid projects. It makes sense to call this Space
Avid Projects.

For information about setting up an Avid Style space, see the following topics:

● Setting up Avid Style on macOS
● Optimizing Avid Style Spaces on a macOS System
● Installing and Configuring EditShare Connect for Windows

Setting up Avid Style on macOS
To set up Avid Style on a macOS workstation, the Avid application cannot be running. You also need to
have Administrator privileges on the workstation so EditShare can make some small permissions changes.

To set up Avid Style:

1. Make sure your Avid application is not running.
2. Start EditShare Connect and login.
3. Click the Settings tab, then click the Avid Style tab on the left side.
4. Click the Enable Avid Style option.

A dialog box may open saying that you need Administrator permission. If so, click OK and enter
your Administrator username and password.

5. Start Avid and create a new project in an Avid Style Media Space.
6. Open a new bin and make sure the green padlock icon displays in the Status  bar.

7. You are ready to use Avid Style Media Spaces on your Mac.

NOTE:  If you upgrade your Avid software, you need to repeat Steps 1-7 the first time you start EditShare Connect.
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Optimizing Avid Style Spaces on a macOS System
EditShare ships several different versions of its Avid Style code in order to support all 32-bit and 64-bit
versions of Avid — from the most recent Media Composer v8 all the way back to Media Composer v2.8
(this includes the corresponding versions of Symphony, NewsCutter, and Xpress Pro). EditShare
Connect automatically uses the Avid Style version that is most compatible with the Avid version you are
running. Once you enable Avid Style you do not have to make any further configuration choices.

However, some older 32-bit versions of Avid software — specifically Media Composer 4.x through 5.5.x
— work with two different versions of EditShare’s Avid Style code. Once Avid Style is enabled in
EditShare Connect, a Configure Avid Style option becomes available that allows you to override the
choices that EditShare makes automatically. You might want to override EditShare’s automatic
configuration in certain circumstances to better support specific workflows or features, such as
exporting AAFs to Avid Style spaces, or mounting Avid Style Spaces by AFP. Overrides affect only Avid
software between v4.x and v5.5.x. See the following table for a summary of the differences between
New and Legacy Avid Style.

Avid Media Composer Version Avid Style Version
(In EditShare Connect)

Support for AAF Exports*

Media Composer 4.0.x Legacy Avid Style (default)

Media Composer 4.0.x New Avid Style X

Media Composer 5.0.x Legacy Avid Style

Media Composer 5.0.x New Avid Style (default) X

Media Composer 5.5.x New Avid Style

Media Composer 5.5.x New Avid Style (default) X

Media Composer 6.x and later New Avid Style* X

* With the Legacy version of EditShare Avid Style, an AAF could not be exported from a sequence in a
bin that was located in an EditShare Avid Style space. To export the AAF, you had to copy the bin to a
local project and export from there. Similarly, if you were trying to export an AAF with embedded
media, with the Legacy version of EditShare Avid Style, you had to first consolidate your media to a local
drive or to an Avid MXF space, and export based on the consolidated media. Both of these issues were
resolved with the New EditShare Avid Style for Mac.

Version Considerations: New Avid Style is not compatible with Media Composer or Symphony
v2.8-3.5.x, and Legacy Avid Style is not available for v6.x and later. Overriding the Avid Style settings
only affects v4.x-v5.5.x of Avid products; selecting New Avid Style for Avid v2.8-3.5.x or Legacy for v6.x
has no effect.
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Installing and Configuring EditShare Connect for Windows
To enable and use Avid Style Spaces on a Windows workstation, you must have successfully installed
the EditShare Connect helper service. You are prompted to install this service every time you install or
upgrade EditShare Connect. While you can install EditShare Connect as a non-administrator, you must
have administrator privileges to install the service. Once it has been installed, any user can enable or
disable support for Avid Style in EditShare Connect. EditShare's Avid Style feature is supported on
Windows XP 32-bit, Windows Vista 32-bit, Windows 7 64-bit, and Windows 8 64-bit.

The EditShare Connect client installer can be downloaded from the server’s status page. Enter your
server’s IP address or host name in your workstation’s web browser. For example, if your EditShare
server is at the IP address 192.168.1.100, enter http://192.168.1.100 in your browser. Click the
“EditShare Connect Clients” link on the page, then click the file ending in .msi to download the Windows
client to the workstation.

NOTE:  Always remember to check the server for an EditShare Connect client after updating the EditShare
server software. EditShare Connect will also notify users upon logging in if an update is available.

You only have to perform this procedure once per workstation, then again after installing Avid software updates.

To enable Avid Style on Windows, you must make EditShare Connect aware of the Avid software
installed on your workstation

1. Start EditShare Connect, log in, and click the Settings tab.

2. Click the Avid Style side tab.
3. Click the Browse for Avid Application button.
4. When Windows Explorer opens, navigate to your Avid application file and then click Open.
5. If you have other Avid applications, repeat steps 2 to 4 for each application.
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Avid MXF Media Spaces in Detail
Avid MXF Media Spaces are designed to allow users of Avid editing software to work together safely. As
the name suggests, these Media Spaces can be used only for media stored in the MXF format, not for
OMF, AIF, or WAV files. Be sure to set your Avid application to capture video as MXF and audio as PCM
(MXF). (If you do not make these changes, you cannot capture into an Avid MXF Media Space.) The
following table describes features of Avid MXF Media Spaces.

Feature Description

Supported NLE All Avid (Media Composer, Avid Xpress Pro, Symphony Nitris, and so
on), only for media stored in MXF format (audio as PCM (MXF)).

Network Protocol Windows: EFS or SMB; macOS: EFS or SMB

Access Control ● Users must be added to the Media Space to have access
● Users can be given read-only access
● Public option available

User Operations ● QuickTime Reference mode
● Hide user folders

Administrator Operations ● Protect/Unprotect mode
● Maintenance mode

Contents ● OMFI MediaFiles (not used)
● Avid MediaFiles/MXF/1 (folder you own, can capture into and

delete from)
● Avid MediaFiles/MXF/# (other folders you own and can delete

from)
● Avid MediaFiles/MXF/user_# (other users’ folders; view only)

If you must capture your media in non-MXF formats, you need to use an Avid Style Space.

When an Avid NLE captures MXF media, it captures it into a folder called Avid MediaFiles/MXF/1 (or
potentially 2 or 3 if the first folder gets full). However, it also sees any media inside other subfolders of
the Avid MediaFiles folder. Each folder has its own media database file, which Avid automatically
updates when it creates or deletes media inside that folder.

EditShare provides you with your own view of that Media Space, and you have your own numbered
folder into which Avid captures. In your view of the Media Space, your own “1” folder is called 1 and you
have full access to capture into it or delete media files from it. Other users' “1” folders, on the other
hand, appear with different names, based on the names of the users, for example, max_1. Avid can see
media in these folders, so you can play the media, mark In and Out points, and incorporate the media
into your sequences. You cannot modify or delete the media there, however, or capture new media
into the folders or use other tools (such as macOS Finder or Windows Explorer) to copy or move files
into these folders.
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The following illustrations show the structure of EditShare’s Avid MXF spaces and Avid Shared
Project spaces.

With Avid MXF spaces, each editor has his or her own view of the Media Space. UserB’s media is stored
in a 1 or 2 folder (and so on). UserB sees UserA’s media in folders called UserA_1 and UserA_2.

However, in another user's view of the Media Space, your numbered folders appear with different
names, and their numbered folders are called “1” and “2” and so on, so that their Avid application
captures uniquely into that user’s folders.

You can create additional folders inside your MXF folder, with numbered names up to three digits (up
to “999”). Avid applications generally do this when all existing numbered folders have more than 5,000
files in them.

Note:  Do not create names with four or more numerals. Names with four or more numerals interfere
with some important EditShare functions.

Also see the following topics:

● Enabling Avid Editing Systems to see Avid MXF Media Spaces
● Making QuickTime Reference Movies from Avid
● Leaving QRM
● Hiding User Folders to Handle Corrupted Media
● Protecting Media with the Protect Function
● Deleting and Organizing Avid MXF Media
● Deleting Avid MXF Media
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Enabling Avid Editing Systems to see Avid MXF Media Spaces
By default, Avid applications do not see EditShare Avid MXF Media Spaces. In order to capture media
into Avid MXFspaces, you must tell your Avid editing system to pay attention to those spaces using the
alldrives command.

alldrives Command
You can use this method for the following Avid applications and versions:

● Avid Xpress Pro v4 and later (except for some Mac OS X versions distributed before March
2004)

● Avid Xpress Pro HD
● Avid Xpress DV v3.5 and later (except for some Mac OS X versions distributed before March

2004)
● Media Composer
● Media Composer Adrenaline
● Symphony Nitris
● NewsCutter
● NewsCutter XP

After you use this method, you should not have to do it again unless you update your Avid software to
a new (major) version.

1. Open a project in your Avid application.
2. Select Tools > Console.
3. Type alldrives 1 and then press Enter.
4. A message opens in the Console window that reads, ‘all drives will be viewed as media drives’.

5. Select File > Mount All.

42



Your application now sees the mapped drives. If there are already media files in your Media
Space, your system might start scanning the Media Space to build a new database. This is
normal and completes in a few seconds or minutes.

NOTE:  If the application does not see the mapped drives, select File > Refresh Media Directories. If it
still does not see the mapped drives, quit the application and restart it.

Making QuickTime Reference Movies from Avid
A side effect of the way Avid MXF Media Spaces present your data to you is that different users see the
same media files in slightly different paths. For example, user edit1 might see a file captured as

Z:\Avid MediaFiles\MXF\1\clip1.mxf

Instead the user edit2 would see that same file as Z:\Avid MediaFiles\MXF\edit1_1\clip1.mxf.

As long as you are only looking at the files within your Avid NLE, this is not a problem – each NLE finds
the correct media file with no difficulty.

However, if user edit1 were to create a QuickTime reference movie of a sequence that uses that clip,
and send it to edit2 to review, edit2 would not be able to see the media because QuickTime does not
know how to locate the media in a different folder.

A workaround is to create special-purpose usernames. See Making QuickTime Movies using
Special-Purpose Usernames.

You can also work around this problem by using QuickTime Reference Mode (QRM). See Making
QuickTime Movies with QuickTime Reference Mode (QRM) and Leaving QRM.

Making QuickTime Movies using Special-Purpose Usernames
The following is the preferred procedure for making QuickTime movies, compared to QRM (see Making
QuickTime Movies with QuickTime Reference Mode (QRM)).

1. Create two new users, called, for example, QTCreate and QTView.
2. Log in as yourself.
3. Render your sequence.
4. Log out.
5. Login as QTCreate.
6. Create the QuickTime Reference file.
7. Log out.
8. To view the file, login as QTView.

NOTE:  Avoid viewing as QTCreate so you do not conflict with another user
who might be creating as QTCreate.
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Making QuickTime Movies with QuickTime Reference Mode (QRM)
When you are in QRM for a Media Space, your own numbered folders in that space temporarily appear
the same way that other users see them. The media stays the same, but the name of the folder is
changed. You can then create the QuickTime reference movie you need, and it contains references to
your media files in a way that other users can use.

You might also need to enter QRM to play a QuickTime reference movie, if that file contains references
to files in your numbered media folders.

NOTE:  While in QRM, you cannot capture or render any new files into that Media Space. Therefore, it is
important that you render any effects in the sequences you need to make QuickTime reference movies before
entering QRM.

To place yourself in QRM to create QuickTime reference movies:

1. Render all effects in the sequences you plan to make QuickTime references of.
2. Close your Avid project.
3. Start EditShare Connect.
4. Click the dropdown menu in the Tools column of the Spaces tab, then select ‘Enable QuickTime

Reference Mode’.

5. A dialog box opens telling you to log out of EditShare Connect and log back in for the changes
to take effect. Click OK.

6. Log out of EditShare Connect.
7. Start EditShare Connect and login again.
8. Open your Avid project again. You can now make the QuickTime reference movies you need.

Leaving QRM
To leave QRM:

1. Close your Avid project.
2. Click the dropdown menu in the Tools column of the Spaces tab, then select Disable QRM.
3. A dialog box opens telling you to log out of EditShare Connect and log back in for the changes

to take effect.
4. Click OK.
5. Log out of EditShare Connect.
6. Restart EditShare Connect and log in.
7. (Optional) Reopen your Avid project.
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Hiding User Folders to Handle Corrupted Media
You might need to isolate media files you do not control. For example, another user might have a
corrupted media file that causes your Avid application to hang. You can isolate that file by using the
Hide User Folders function to hide one or more users' numbered MXF folders.

The EditShare Administrator can also hide user folders for any user. This can be done when a problem
has been discovered and the Administrator wants to hide it from other users without bothering them
with it. See Hiding User Folders to Handle Corrupted Media.

To hide user folders:

1. Start EditShare Connect.
2. Click the drop down menu in the Tools column of the Spaces tab, then select Hide MXF

Directories.
3. The Avid MXF Media Management dialog box opens.
4. Select each folder you want to hide.
5. Click OK.

The number of hidden folders appears in that space’s Status column, and the Hide MXF
Directories option in that space’s Tools menu changes to Show All MXF Directories.

6. (Optional) Select Show All MXF Directories to show all the hidden folders and restore normal
operation.
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Protecting Media with the Protect Function
In many environments, it might be inappropriate for a user who captured media to be able to delete it.
For example, a group of assistant editors might do logging and capturing, but they would not be
expected to delete captured media.

To protect captured media from being modified by even the user who captured it, the EditShare
Administrator (or a designated Limited Administrator) can use the Protect function. This makes all
media already captured by a specific user read-only. Such media can no longer be moved, renamed,
deleted, or modified by any user, including the user who originally created it. The user can still delete
any new media he or she adds subsequently until the Protect function is run again.

One way to use this might be for the Administrator to protect the media on a daily basis, when the
assistant editors are finished capturing. The assistant editors could delete erroneously captured files
immediately, but after the Administrator protects the media, making changes requires additional
maintenance.

The Administrator can also unprotect media created by one or more specific users, returning to each
creator the ability to move, rename, delete, or modify all the files which had previously been protected.

It is not necessary to use the Protect and Unprotect functions in order to work with an Avid MXF Media
Space. If you do not use the Protect function, all your files are always under your control. However, the
Protect function is the only way to ensure that media files in an Avid MXF Media Space are not
mistakenly or maliciously modified. In an environment where media files are shared among many
users, it can be very disruptive if important files are deleted.

For instructions on using the Protect and Unprotect functions in Avid MXF Media Spaces as an
Administrator, see the EditShare Administrator's Guide. For Limited Administrators, see Chapter 6:
EditShare Limited Administrator.

Deleting and Organizing Avid MXF Media
Any user who captured files into an Avid MXF Media Space can normally delete those same files (unless
the Media Space has been Protected). But when it is time to delete unnecessary files from a Media Space,
it can be impractical to require each individual editor to participate in “cleaning up.” For example, a Media
Space might have clips that were captured by many different people, and the lead editor wants to delete
media that is not in use without having to involve all the users who captured the files.

To address this need, the EditShare Administrator (or a designated user) can place an Avid MXF Media
Space into Maintenance Mode, giving one specified user (called the “maintenance user”) the ability to
freely move, rename, delete and modify files in that Media Space regardless of who originally captured
them. See Deleting Avid MXF Media. The maintenance user should be selected carefully, as he or she
has the ability to do great damage to the media.

If you are the maintenance user, you see a change in the names of other users' subfolders of the MXF
folder. Instead of seeing names such as user2_1, the subfolder names change to purely numeric
names, such as 5011. This allows your Avid application to modify the contents of all the folders,
including their media databases. A file called maintenance_users.txt is created in the top-level folder of
the Media Space, providing a table linking the original names of the folders to their new names in
Maintenance Mode. This helps you to know which folders are owned by which users.

It is generally best, if possible, to have all other users besides the maintenance user unmount from the
Media Space before maintenance begins. If any users have the Media Space mounted during
maintenance, you might notice the following:
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● All other users are restricted to read-only access. In fact, an Avid MXF Media Space cannot be
put into Maintenance Mode while any files are being captured or rendered into it, and while in
Maintenance Mode it is not possible for anyone other than the maintenance user to save any
new files into the Media Space.

● Other users immediately see the changes being made by the user who is doing maintenance.
Files might disappear or be moved without warning to them. This might be confusing.

● If you have a file open (that is, if you are playing the media from it) when the maintenance user
attempts to move or delete the file, the operation might not happen as intended. A file cannot
be deleted while it is open. It should be deleted after it is closed (that is, when you stop
playback) but this might not be completely reliable.

Deleting Avid MXF Media
To delete Avid MXF media in Maintenance Mode:

1. Make sure all other users have unmounted the Media Space from which you want to delete media.
2. Ask your Administrator to place the Avid MXF Media Space into Maintenance Mode for a

particular user.
3. Open EditShare Connect as the Maintenance Mode user.
4. Start the Avid application.
5. Select the shared project space.
6. Create a new local bin.
7. Copy, duplicate, or move the media you want to delete to the local bin.
8. Delete the media metadata and media files.
9. Close the Avid application.

NOTE: You must close the Avid application before the Media Space is taken out of Maintenance Mode.
After you delete clips, Avid might not modify its media databases until the application is closed. If the
Media Space is taken out of Maintenance Mode first, you can no longer modify the media database
files in other users' numbered MXF folders.

10. Ask the Administrator to take the Media Space out of Maintenance Mode. The Administrator
can save a backup copy of all deleted files into the EditShare Trash for possible restoration in
case it is later discovered that one or more files were deleted that should not have been.
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Managed Media Spaces
Managed Media Spaces are designed to allow users of non-Avid editing software to work together
easily, while still protecting files from inadvertent modification or deletion. The following table
describes features of Managed Media Spaces.

Managed Media Space Feature Description

Supported NLE Final Cut Pro, Adobe Premiere Pro, Media 100, Edius Canopus,
Avid (formerly Pinnacle) Liquid, and so on (Avid can import from
or export to a Managed or Unmanaged Media Space).

Network Protocol Any SMB or AFP

Access Control ● Users must be added to the Media Space to have access.
● Public option.

User Operations None

Administrator Operations ● Protect/Unprotect mode.
● Maintenance mode.

Contents Created as necessary by NLE.

In a Managed Media Space, all editors access the same view of the Media Space. Files you capture,
render, transfer, import, or otherwise create in the Media Space are immediately visible to other users.
You can create subfolders inside the Media Space, and you can move, rename, delete, or modify the
files you have captured any way you like to organize and manage your media. However, you cannot
modify files that other users created, and they cannot modify files you created.

Managed Media Spaces do not provide any special folders for your use. You can freely create whatever
folders you need to organize your media in whatever way works for your organization. Most NLE
software automatically creates some folders (for example, Final Cut Pro creates a Capture Scratch
folder to capture media into), and you are free to create any additional folders supported by your NLE.

In a Managed Media Space, you may not rename, move, or delete folders with contents. This protects
media from accidental deletion. Once the contents of a folder have been moved elsewhere or deleted,
the folder may be modified.

Do not try to use Managed Media Spaces as a capture or render destination for Avid editing software,
unless only one editor ever mounts the Media Space at a time. If two editors ever mount the Media
Space at the same time and run Avid, it is very likely that the media database in the Media Space will
become corrupted, making your media inaccessible until the media database is rebuilt. However, it is
safe to use a Managed Media Space as a source from which you import files into Avid (which stores
them in an Avid MXF or Traditional Avid Media Space), or as a destination into which to export files
from Avid.
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Tracking Who Controls Files in Managed Media Spaces
There is no automatic way to see or track which user created (and therefore controls) files or folders on
a Managed Media Space. However, you can establish a convention in your organization that allows you
to easily track who controls which files.

Each editor can make their own folder inside the Media Space, and capture and render files into only
that folder. For example, a Managed Media Space used for a Final Cut Pro project could have a folder
structure that looks like the following:

Max can access Allan’s files, and vice versa, but the two sets of files stay separate. In a Managed Media
Space, nothing prevents Max from capturing files into Allan’s folder. Editors must take responsibility for
following the conventions established for the organization.
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Organizing Media by Tape or Subject
Final Cut Pro editors often want to organize captured media files by tape number or subject matter
within a single Capture Scratch folder. Even though Final Cut Pro only captures into the main Capture
Scratch folder, a Managed Media Space allows the editor who captured files to move them into any
other folder in the Media Space.

Create the media folders structure the way you want it inside the Media Space. Then, after you capture
some clips, move the media files out of the main Capture Scratch folders into those “subject matter” folders.
For example, you might create the following folder structure for a TV program about the Mediterranean.

Files should be properly named and moved before other editors start working with them, or else the files
might suddenly go offline and other editors have to reconnect the clips in their sequences.

Protecting Media with the Protect Function
In some environments, it might be inappropriate for a user who captured media to be able to delete it.
For example, a group of assistant editors might do logging and capturing, but they would not be
expected to delete captured media.

In order to protect captured media from being modified even by the user who captured it, the
EditShare Administrator (or a designated user) can use the Protect function. This makes all media
already captured by a specific user read-only. Such media can no longer be moved, renamed, deleted,
or modified by any user, including the user who originally created it. The user can still delete any new
media he adds subsequently, until the Protect function is run again.

One way to use this might be for the Administrator to Protect the media on a daily basis, when the
assistant editors are finished capturing. The assistant editors could delete erroneously captured files
immediately, but once the Administrator Protects the media, making changes requires additional
maintenance.

The Administrator can also Unprotect media created by one or more specific users, returning to each
creator the ability to move, rename, delete, or modify all the files which had previously been Protected.
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It is not necessary to use the Protect and Unprotect functions in order to work with a Managed Media
Space. If you do not use Protect, all files are always under the control of the user who created them.
However, Protect is the only way to ensure that media files in a Managed Media Space are not
mistakenly or maliciously modified. In an environment where media files are shared among many
users, it can be very disruptive if important files are deleted.

Instructions for the Administrator to Protect and Unprotect Managed Media Spaces can be found in
“Protecting Media Spaces” in the EditShare Administrator's Guide.

Deleting and Organizing Managed Media
Any user who captured files into a Managed Media Space can normally delete those files (unless the
Media Space has been Protected). When it's time to delete unnecessary files from a Media Space,
however, it can be impractical to require each individual editor to participate in “cleaning up.” For
example, a Media Space might have clips that were captured by many different people, and the lead
editor might want to delete media that is not in use without having to involve all the users who
captured the files.

To address this need, the EditShare Administrator (or a designated user) can place a Managed Media
Space into Maintenance Mode, giving one specified user (called the “maintenance user”) the ability to
freely move, rename, delete and modify files in that Media Space regardless of who originally captured
them. The maintenance user should be selected carefully, as he or she can potentially do great damage
to the media.

It is generally best, if possible, to have all other users besides the maintenance user disconnect from
the Media Space before maintenance begins. If any users remain connected during maintenance, you
might notice the following:

● All other users are restricted to read-only access. No one besides the maintenance user can
save any new files into the Media Space while it is in Maintenance mode.

● Other users immediately see the changes being made by the user who is doing maintenance.
Files might disappear or be moved without warning. This can be confusing.

● If you have a file open when the maintenance user tries to move or delete it, the operation
might not happen as intended. A file is not deleted while it is open. Consider further the
following:
○ If the Media Space is mounted using SMB, the file should be deleted once it is closed (that

is, not being played), but this might not be completely reliable.
○ If the Media Space is mounted using AFP, the file is not deleted and no warning is given to

the maintenance user. It appears that the file was deleted, but it was not.

When the maintenance is complete, the Administrator can confirm the changes and leave Maintenance
Mode. A backup copy of all deleted files can be saved in the EditShare Trash for possible restoration if it
is later discovered that one or more files were deleted that should not have been. See the EditShare
Administrator's Guide for information about restoring deleted files.
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Universal Media Spaces
Universal Media Spaces are only for use with EditShare Flow. For more information, see the FLOW
documentation.

Unmanaged Media Spaces
In an Unmanaged Media Space, all files are immediately visible to and accessible by other users. Users
can create folders and rename, move, or delete any files or folders inside the space, regardless of
whether they created those files or folders. Any user with access to the space can also modify any other
user’s files. There are no restrictions or controls to protect against accidental or malicious overwriting
of specific files or folders.

The following table describes the features of Unmanaged Media Spaces:

Feature Description

Supported NLE Limited support for all NLEs except Avid (Avid can import from or
export to a Managed or Unmanaged Media Space). Compatible
with stored FCP X Events and Projects. Best for ProTools sessions.

Network Protocol Any SMB or AFP

Access Control ● Users must be added to the Media Space to have access.

● Up to 20 users can be limited to read-only access
● Public option.

User Operations None

Administrator Operations None

Contents Created as necessary by NLE.

In general, EditShare recommends using Avid MXF, Avid Style, or Managed Media Spaces instead of
Unmanaged Media Spaces. If you choose to use an Unmanaged Media Space, you must carefully
coordinate with other users to be sure you do not modify or delete files that other editors might rely on.

Unmanaged Media Spaces do not provide any special folders for your use. You can freely create
whatever folders you need to organize your media in whatever way works for your organization. Most
NLE software automatically creates some folders (for example, Final Cut Pro creates a Capture Scratch
folder to capture media into), and you are free to create any additional folders supported by your NLE.

Do not try to use Unmanaged Media Spaces as a capture or render destination for Avid editing
software, unless only one editor ever mounts the Media Space at a time. If two editors mount the
Media Space at the same time and run Avid, it is very likely that the media database in the Media Space
will become corrupted, making your media inaccessible until the media database is rebuilt. However, it
is safe to use an Unmanaged Media Space as a source from which you import files into Avid (which
stores them in an Avid MXF or Avid Style Media Space), or as a destination into which to export files
from Avid.
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Selecting and Managing Spaces
EditShare Connect makes it easy to find and select relevant Media and Project Spaces.

Searching for Spaces in EditShare Connect
You can search EditShare Connect for Media and Project Spaces by name, filtering the list of available
spaces to show only those that contain whatever text you enter. This makes it easy to quickly find,
mount, or manage a specific space when you already know its part or all of its name.

NOTE: The search function only filters the spaces in the currently selected Profile. To search all spaces, you
must first select the All Spaces Profile. See Creating and Using EditShare Connect Profiles.

To search for a space in EditShare Connect:

1. In the Spaces tab of EditShare Connect, click the Search button.
2. A search field displays below the Search button.

3. Enter the text you wish to search for in the Filter Spaces field.
4. The list of Media and Project Spaces changes to show only those that contain the provided text.
5. To restore the list of spaces, clear the Filter Spaces field or click the Search button.
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Creating and Using EditShare Connect Profiles

About Profiles
When working on a single editing project, it is not unusual for editors to want to mount more than one
Media Space. For example, the editor might put all raw clips into one space that's dedicated just for
that project. Then the editor might put render files into a second space that is also dedicated just for
that project to help keep renders segregated so that they are easy to manage and delete. There might
be a third space with a music library that is used over and over again for many projects, and a fourth
space for graphics elements and stills.

On complex projects – for example, a multi-part documentary or reality series – it is not unusual to
have different spaces for each episode or day of shooting. It is also not unusual for editors to need
material from other episodes in addition to the specific one they're working on – for instance, for things
like recaps and previews.

To help make it easy to switch between editing projects and always have the correct spaces mounted,
EditShare includes a Profile feature that lets you group spaces so that you can mount all of them at the
same time in EditShare Connect.

For example, if your facility has projects for both Cola Co. and Pop Inc., you would not want to
accidentally use Cola Co.’s stock shots in a Pop Inc. commercial. You can have a Profile for each client
so that any time you have a job for that client, you can instantly connect to all the spaces associated
with that client. In this scenario, Profiles help you organize your spaces into groups for each client while
still allowing you to rapidly switch between clients.
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By default, the first time you launch EditShare Connect, it opens up with the ‘All Spaces’ Profile. As the
name implies, the All Spaces Profile will always show you all the spaces that you have access to. After
loading the All Spaces Profile, you can mount spaces manually - when you log out, whatever spaces you
had mounted when you logged out (and for Windows users, whatever drive letter they were assigned
to) will be remembered when you log back in.

The Administrator for your EditShare system may create other Profiles that are available to everybody.
These are called Public Profiles.

The real power of Profiles, however, comes when you start creating Profiles that are tailored for specific
projects. When you create a new Profile, you give it a name and – if you want – you can choose an
existing Profile to use as the base or template for the new one. You can only edit your own Profiles,
though you can use Public Profiles as the source for creating a new private Profile.

For information about creating and managing Public Profiles as an Administrator, see the EditShare
Administrator’s Guide for additional information.

Selecting a Profile
To select a Profile:

1. Make sure the Spaces tab is selected.

2. Click the Change Profile button.
3. The Spaces panel changes to Profiles view, and displays both Public and Private Profiles in a

menu bar.
4. Double-click the name of the Profile you want to use to select it.
5. The Spaces panel returns to normal view, and displays the Profile you selected together with its

associated spaces mounted.
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Creating a Private Profile
You can use an existing Profile, Public or Private as a basis for your Profile, or you create a Profile from
scratch. You cannot create Public Profiles. To create a Private Profile:

1. Make sure the Spaces tab is selected.

2. Click the Change Profile button.
3. The Spaces panel changes to Profiles mode.
4. Click on the New button.
5. In the Name field, type a name for your new Profile.
6. (Optional) If you want to use an existing Profile as the starting point for your new Profile, select

one of the Profile names. You can select multiple existing Profiles, and the combined spaces will
be selected automatically in your new Profile.

7. If you have a lot of Profiles displayed, type part of the name in the Filter field to show only the
Profiles that contain the letters you typed.

8. Click on the Create button to create the new Profile.
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9. Select one or more spaces to add to the Profile and indicate whether the space should be
mounted by default or not. If you are running Microsoft Windows, select the required drive
letter from the drop down  list.

NOTE: It is possible to have unmounted spaces in a Profile. For instance, it is not possible on Windows
to simultaneously mount more spaces than there are available drive letters, but you might still want
to keep all of the spaces in your Profile.

10. When you are done adding spaces to your Profile, click the “Finish Editing” button.
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Editing a Profile
If you attempt to edit a Public Profile, any changes you make are not saved when you quit EditShare
Connect. To edit a Profile:

1. With your Profile already loaded, click the Edit Profile button.

2. The Edit Profile button label changes to ‘Finish Editing’ and the Spaces panel changes to Edit
view, displaying all available Media Spaces.

3. Select one or more spaces to add or remove from the profile. If the spaces are to be included in
the Profile, select whether to mount them or not. On Windows workstations, select the drive
letter required for each space.

4. Click the Finish Editing button when you have completed your changes.

Deleting a Profile
When you delete a Profile, EditShare Connect does so without issuing a warning message beforehand.
To delete a Profile:

1. Click the Change Profile button.
2. The Space panel changes to Profile view.

3. Click the Profile you want to delete to highlight it.
4. Click the Delete button.
5. The Profile is deleted immediately without displaying a warning message.
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Requesting Bandwidth Reservations
EditShare Storage servers include a Quality of Service/Bandwidth Reservation system that can help
ensure that realtime activities such as video ingest (capture) and video playback (including ‘digital cuts’
and ‘print to video’) always get the highest priority – so that these activities can succeed without
dropping frames no matter how intensively you are using your storage for other non-realtime activities.
This system allows the EditShare administrator to grant editors the privilege to reserve bandwidth and
limit how much each editor can request. Privileged editors see a special feature in their EditShare
Connect client that allows them to request and release bandwidth.

A privileged editor does not get the extra bandwidth immediately. Instead, the editor requests a
reservation in EditShare Connect up to the limits set by the administrator.

To reserve bandwidth:

1. In EditShare Connect, click on the Spaces tab.

2. If you have the appropriate privileges, a Reserve Bandwidth button displays in EditShare
Connect. Click the button to open the Reservation dialog box.

3. The Request Bandwidth dialog box opens:
a. The maximum bandwidth you can request displays at the top.
b. Select the activity you want to use the bandwidth for - Playout or Capture.
c. Select the bit rate you want to use from the drop down list.
d. Select the number of streams you require from the drop down list.
e. The total bandwidth you requested displays at the bottom of the dialog box.

4. Click the Reserve Bandwidth button to send your request.
5. The Administrator for your EditShare system then views, renews, or deletes the reservation in

the Quality of Service tab of an EditShare Manager.

For more information about managing bandwidth reservations as an Administrator, see the EditShare
Administrator’s Guide.

Reservations are deleted automatically when you log out of EditShare Connect.
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Chapter 5: Metadata Spaces
EditShare considers all files that are not media files to be metadata files. Depending on your NLE,
metadata might include project files, bins, sequences, and settings files. The essential fact about
metadata files is that they are frequently changed during the course of editing.

Private Files Spaces
Unless the EditShare Administrator disables this feature, you are provided with a Private Files space on
the EditShare server. This is a private Space for your exclusive use. The following table describes
features of Private Files spaces.

Private Files Space Feature Description

Supported NLE N/A

Network Protocol SMB or AFP

Access Control Each user has one Private Files folder, accessible only by that user.

User Operations None

Administrator Operations All Private Files spaces can be disabled by the Administrator.

Contents Created by user.

Your Private Files space is a private place to store project metadata files on the EditShare Server. It is not a
place to put media files. In fact, EditShare blocks most media files from being stored in your Private Files
space (any file with a *.omf, *.mov, *.aif, *.wav, *.avi, *.mp3 extension, among others). The EditShare
server stores all users’ Private Files spaces on a drive of limited capacity. If you were to store media on it,
you would quickly fill the drive and prevent everyone else from using their Private Files spaces.

Private Files spaces are the safest place on the EditShare Server to store your personal metadata files.
Only you can access your Private Files space. No other user can access or erase your project data
unless they know your username and password. You can access your Private Files space from any
computer on your network, which allows you to create, open, or modify your projects from any
workstation where you can log in.

It is possible that your access to your Private Files Space has been disabled by your Administrator. To
access your Private Files space in this scenario, ask your EditShare Administrator.
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SMB File Exchange
The SMB File Exchange space is a public location that can be accessed by anyone who logs onto the
EditShare Server.

The following table describes features of File Exchange Spaces.

File Exchange Space Feature Description

Supported NLE N/A

Network Protocol SMB

Access Control All users can freely read and write.

User Operations None

Administrator Operations File Exchange Spaces can be disabled by the Administrator.

Contents Created by user.

The purpose of the File Exchange Spaces is to allow editors to exchange metadata files with each other.
For example, you could copy project files, bins, or sequences you want to share into a File Exchange
Space, and other editors who want to work with those files in turn can copy the files into their own
private Space, that is, their own Private Files Space on the EditShare Server, or into a project folder on
their own local computer.

Like your Private Files Space, the File Exchange Spaces are not the place to put media files. The File
Exchange Spaces are located on a drive of limited size, and if you were to store media in them, you
would quickly fill the drive and prevent everyone else from using their File Exchange Spaces.

The File Exchange Spaces are readable and writable by everybody. Any file put there can be modified or
deleted by anybody. You should not consider the File Exchange Spaces to be secure or safe places to
store your personal files. They are only places for trading copies of those files.

NOTE:  At no time should you directly open up project files, bins, or sequences from the File Exchange Spaces,
as there is no guarantee that other editors will not also do the same thing. If two editors open exactly the
same project file, bin, or sequence, important data might be lost.

Your access to the File Exchange Space might be disabled by your Administrator. To access your File
Exchange Space, see your EditShare Administrator.
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Spaces for Storing and Sharing Avid Projects
Avid projects consist of metadata files that represent bins, sequences, and preferences. Whenever you
create a new project with your Avid application, Avid creates a folder in the place you specified in the
Select Project window, with the name you gave the project. Avid normally stores these files on your
local drive.

You can override the default and store Avid projects wherever you want, however, including in an
EditShare Avid Shared Project Space or an Avid Style Space. Inside each Avid project folder, Avid creates
a settings file that contains information about how you have customized your Avid application for that
project, and a bin file for each of the bins you create in your project. These folders and files do not
contain any media clips. They contain only metadata that refer to the media clips stored elsewhere, for
example, on your EditShare server.

If you want to collaborate or share projects, you need to store your project files on the EditShare
server. The key to successful project sharing is that no two editors should be allowed to modify the
same metadata files at the same time. This is called metadata or file locking.

There are three methods for collaborating on an Avid project with other users:

● Create your Avid projects in an Avid Style space. Many facilities like to make a dedicated Avid
Style space just for projects and keep their media in various other Media Spaces. (While you can
keep your media with your project, you do not have to.) See EditShare Avid Style Sharing.

● Use Avid Shared Project Spaces (see Shared Project Spaces). This allows multiple Avid editors to
work simultaneously on the very same metadata files without danger.

● Trade Avid bins between editors (whether you keep them on your local hard driver or in your
Private Files Spaces).

Also see the following topics:

● Sharing Avid Projects Using Avid Shared Project Spaces
● Creating a New Avid Shared Project
● Collaborating by Copying Metadata
● Sharing Media without Collaborating on Projects
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EditShare Avid Style Sharing
EditShare offers a way to share Avid media and projects called Avid Style sharing. If you are accustomed
to working with Avid Unity or Avid ISIS, you will find EditShare Avid Style sharing very familiar.

This section presents all the information you need to set up and use Avid Style sharing.

Introduction to Avid Style Sharing
While EditShare pioneered the first non-Avid system for sharing bins, sequences and media, EditShare
offers an additional system for collaboration with these assets. Avid Style Sharing provides bin-locking
and media sharing that works the same way as Avid's Unity and Isis storage.

Each approach has its advantages. For example, the original EditShare way of sharing bins via User
folders is probably much more secure for schools and big organizations where individual editors want
some guarantee that their bins and sequences cannot be modified by others. Similarly, deleting files
and rebuilding media databases is both safer and easier with EditShare's Avid MXF spaces.

If you are an Avid editor accustomed to the way Unity works, however, you do not need to learn a new
way of doing things. With EditShare's Avid Style Sharing, you get both Avid Style bin-locking and the
Avid way of associating media files with the workstation that created them. In addition, with Avid Style
Spaces, you get a small performance boost that can be important when you ingest or output sequences
with six or more audio tracks.

With EditShare, you are not forced into using only one approach. For example, you can use Avid MXF
Media Spaces for your media and Avid Style Media Spaces for your bins.

For Avid projects stored in Avid Style Media Spaces, any bin can be opened Read-Write by the first user
who opens it. This is represented in the Avid application by a green lock icon on the bin.

Any subsequent users have only Read access, which is represented by a red lock icon.
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Avid Style Workflow
The general process of using Avid Style sharing is as follows:

1. Create an Avid Style Media Space for your Avid project in EditShare Manager. See Avid Style
Media Spaces in Detail and Creating Media Spaces in the EditShare Administrator’s Guide.

2. (Mac only) Enable Avid Style in EditShare Connect. See Setting up Avid Style on macOS.
3. Create a new Avid project in the Avid Style Media Space, and work in the project with your

shared media. See Sharing Projects with an Avid Style Media Space.

Sharing Projects with an Avid Style Media Space
To share projects with an Avid Style Media Space:

1. Login as Administrator on your workstation.
2. Start EditShare Connect and mount an Avid Style Media Space.

3. Start the Avid application.

NOTE:  If you want to start Avid without using the Avid Launcher, you must Disable Avid Style in the
Avid Style section of the EditShare Connect Settings tab.

The Select Project dialog box opens.

4. Create a new External project in the Avid Style Media Space your system Administrator created
for your Avid projects.
● When you open a bin, the lock icons display – green for unlocked and red for locked.
● The first user to open an unlocked bin can make changes to it.

Unlike regular Shared Project Spaces, you do not have to Share the new project for other
users to have access to it.

5. Right-click the bin and select Lock or Unlock.

See your Avid documentation for additional information on using locked and unlocked bins.
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Restrictions on Modifying Media
The following restrictions pertain to an Avid Style Media Space:

● All files are owned by all of the members of the Media Space—including media files, media
database files, project settings and bins—and any member can permanently modify or delete
files from an editing application, macOS Finder, or Windows Explorer.

● Any bin can be opened Read-Write by the first user who opens it. Any subsequent users who
open it while it is still open by the first user have only Read access. This is represented by a
green lock icon on the bin opened by the first user, and a red lock icon for subsequent users.

Sharing Avid Projects Using Avid Shared Project Spaces
Avid Shared Project Spaces are often preferred by schools and universities because write access is
controlled by the User Folder where a bin resides, unlike with Avid Style spaces, where the first user to
open a bin gets write access, with Shared Avid Project Spaces. In an Avid Shared Project Space, User A
cannot take a bin out of User B’s folder. User A has only read-only access to User B’s bins unless User B
wants to give up control over the bin.

The following illustration shows EditShare’s Avid Shared Project Spaces.

The process of working with an Avid Shared Project Space is generally as follows:

1. The EditShare Administrator creates the Avid Shared Project Space and adds users to it.
2. You create an Avid project in the Avid Shared Project Space, set the project settings, and Share

it using EditShare Connect.
3. All users have their own folders within the project and can create bins in them.
4. You capture media, create and edit sequences, and perform other editing functions.

Creating a New Avid Shared Project
Once the EditShare Administrator has created an Avid Shared Project Space, you can create and share
Avid Projects in it by doing the following:

1. Use EditShare Connect to mount the Avid Shared Project Files Space on a drive letter (Windows)
or via EFS or SMB (macOS).

2. Mount one or more Media Spaces in which to store captured media and rendered files for this
new project.

3. Start your Avid application. The Select Projects dialog box opens.
4. Click the Folder button and navigate to the Avid Shared Project Space.
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NOTE:  Do not select the Archive folder inside the Space. You cannot Share a project inside the
Archive folder.

5. Create an Avid project. You are the only one who can access the project; it has only a single bin
that shares the name of the project.

6. Close the project.
7. Start EditShare Connect and click the Projects tab.
8. Click the Refresh button to update the display and show the new project.

9. Select the new project and click the Share Projects button.
10. Return to the Avid application and open the project.

NOTE:  Once a project has been Shared, do not try to move or rename it. This causes your project to
stop working correctly. The EditShare Administrator can organize projects using EditShare Manager.

Set Project Settings before Sharing
When you Share an Avid project, EditShare gives a copy of the project settings file to each user in the
Shared Project Space. These become the initial project settings that each user has when first opening
the shared project. If you want your project to have specific settings that are used by all editors (for
example, to use the 1080i format and capture with PCM sound), save these settings before Sharing the
project. Otherwise, each editor has to correct his or her own settings later.

Collaborating by Copying Metadata
Avid saves each bin you create as a separate file, which contains all the metadata information about all
the clips and sequences in the bin. You must have at least one bin for every Avid project, but editors
usually create multiple bins for each project.

If you choose not to use EditShare’s Avid Project Sharing feature, you can still work collaboratively by
trading copies of bins among multiple editors, a technique that has been used since Avid systems first
came out. EditShare makes trading bins easy by providing an easily accessible public Space where
editors can swap bins.

Due to the way Avid stores captured clips, it is difficult for other editors to simply look at the Media
Space and import the clips they need, as they might with other NLEs. It's much easier to create one or
more bins full of captured clips, and then put a copy of those bins in the Shared Project Files Space on
EditShare. Other editors can then copy those bins into their own project folder, and have the clips. Note
that only the metadata about the clips is being copied in this procedure, not the media itself. A single
copy of the media remains in the Media Space, accessed by all editors.

To work collaboratively:

1. Create a project, and capture media into a Media Space.
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2. Create sequences in one or more bins.

NOTE: It can be helpful to copy specific items into one bin that you plan to share, naming it clearly.

3. Save the bin you want to share.
4. Open the following folders on your desktop:

● The folder where you store your Avid projects
● The Shared Projects Files Space on the EditShare Server

NOTE:  You can create shortcuts on your desktop to these folders, making them easier to find when
you need them.

5. Inside the Shared Project Files Space, make a new folder with your name.
6. Copy the bin you want to share from your private Avid Projects Space to the new folder in the

Shared Project Files Space.

NOTE:  If you store your Avid Projects files on your local workstation, you can copy the bin you want
to share to the EditShare Server’s Shared Project Space by dragging the bin from your local folder to
the server folder. Because these folders actually reside on two separate volumes (one on your local
workstation and one on EditShare), when you move the bin from one place to another, Windows and
macOS copy the bin rather than cutting and pasting. (This might not work if you store your Avid
project files on the EditShare server.)

7. The other editor can now copy the shared bin from the Shared Project Files Space on the
EditShare server to his or her private Avid Projects Space, can open your clips and sequences,
and drag them into another bin.

8. Delete the bin from the Shared Project Files Space on EditShare when nobody else needs a copy.

Adding Titles to Shared Projects
When you add a title to a sequence in a shared project and save the sequence in a shared bin, another
user might see the title as offline. To enable other users to see a new title, you need to close the bin
after you save it. If that doesn’t work, select File > Refresh Media Directories in the Avid application.

Deleting Avid Projects from a Shared Project File Space
It is impossible for individual editors to delete an Avid Project from an Avid Shared Project Space once
the Avid Project has been shared. Only the EditShare Administrator can delete a Shared Project. For
more details, see the EditShare Administrator's Guide.

Sharing Media without Collaborating on Projects
Even if you do not want to share Avid Projects or bins, you can still use Avid's Media Tool to find and
use clips that another user has captured into a Media Space that you have access to. You can sort clips
in the Media Tool by name, date, or tape number. When you find the clips you're looking for, drag them
into a bin in your current project. This creates a new pointer to the clip that you can use. The media file
itself is not duplicated. See your Avid application Help for more information.
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Project Sharing with Non-Avid NLEs
In order to use EditShare's Project Sharing features most effectively with NLEs other than Avid, it helps
to think about projects a little differently than you might have in the past. Normally, a project consists
of a single project file. That is, no matter how many clips, bins, or sequences you have in your project,
all the information is packaged up in one big project file. Unfortunately, having everything in a single
project file makes it impossible to give different members of a group of editors exclusive control over
different parts of a project. This makes it very difficult to work collaboratively. Furthermore, as many
Final Cut editors have experienced, when project files get very large, it can take a long time to open
them, because the NLE must locate every media file referenced by the project file.

Some other nonlinear editing programs (such as Avid or Edius) create a separate file for each bin inside
the project. The project itself is represented by a Project Folder, which contains the files representing
each bin in the project. That kind of structure makes it possible to assign specific rights to individual
bins – each of which represents a different part of the overall Project.

Although Final Cut Pro and Adobe Premiere Pro were not designed to work this way, it is easy enough
to use them this way. Because the NLE allows you to open up more than one Project at the same time,
you can treat the Project files the same way many other NLE programs treat bins.

That is, whereas in Avid you might have one or two bins for rushes and a separate bin for each
sequence, with the other NLEs you can create a separate Project file for each part of the project and
open up multiple project files to see as much of the Project as you need to see to work on it. A
complete Project actually ends up being a folder full of smaller Project Files.

This scheme has the following advantages over the traditional way of working with projects:

● Different ownership rights can be assigned to each Project file, allowing multiple editors to
open up the same files at the same time while ensuring that only one editor at a time can write
to that file.

● You can open only the part of the project that you need to work with, saving time by not having
to open a huge project to work with only a small piece of it.

● Your work is not impaired. If you are working on Act 1 of a program and Editor 2 is working on
Act 2, each of you can open both your own project file (containing the act you are working on),
and also an Assistant Editor's Rushes Project file, for example, that contains all the rushes and
subclips. You can copy the clips you need from the Assistant Editors Project into your own Act 1
Project file (this only copies clip, subclip and sequence references – it doesn't duplicate any
media files). You can also work directly from the Assistant's Project and drag clips into a
sequence that is saved in your own Act 1 Project file. And if Editor 2 wants to see what you are
doing, he or she only needs to open your project and view the sequences it contains.

EditShare offers two different types of spaces for sharing Final Cut Pro and Adobe Premiere Pro projects:

● Non-Avid Shared Project Spaces
● Lockable Project Spaces

In Non-Avid Shared Project Spaces, control over project files is determined by the user folder where the
file resides. In Lockable Project Spaces, Read-Write access to a project file is given to the first user who
opens the file. Subsequent users are restricted to Read-Only access. Lockable Project Spaces work
much the same way as Avid Unity and ISIS, only for other NLEs such as Final Cut Pro and Adobe
Premiere Pro.
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Shared Project Spaces
Non-Avid Shared Project Spaces are available to help Final Cut Pro and Adobe Premiere Pro users
collaborate on projects.

The process of working with a non-Avid Shared Project Space is generally as follows:

1. The EditShare Administrator creates the non-Avid Shared Project Space and adds users to it.
2. The EditShare Administrator or an editor creates a Project Folder inside the Shared Project Space.
3. You have your own folder within the project and can save Project Files in them.
4. You capture media, create and edit sequences, and perform other editing functions.
5. When the project is complete, the EditShare Administrator deletes the project from the Shared

Project Space, or deletes the entire Space itself.

Do not try to move or rename a project. This causes your project to stop working correctly. The
EditShare Administrator can organize projects using EditShare Manager.

The following table describes features of Non-Avid Shared Project Spaces.

Shared Project Space Feature Description

Supported NLE Final Cut Pro 6 and 7, Adobe Premiere Pro

Network Protocol SMB Only

Access Control Users must be added to the Project Space to have access.

User Operations Share project files (Avid only), Create Project (non-Avid only).

Administrator Operations Manage Shared Project Files Space.

Contents Projects as organized by users
Within a user’s view of each project:

● Root
● User’s folder
● Other users
● Group Bins
● Unprotected bins (Avid) / Unprotected projects (non-Avid)

New Features Group Bins folder
Project browser to help organize bins and project files

When editors work together, the ideal workflow is that all editors can work simultaneously on the same
metadata files, allowing them to instantly see what everybody else has created without having to copy
files back and forth. In order to work collaboratively in this manner, you need to have a way to lock and
manage project files so that one editor cannot overwrite the work of another.
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The EditShare Administrator creates one Shared Project Space for editors who need to work together.
You can be a member of as many Shared Project Spaces as necessary. Like a Media Space, a Shared
Project Space allows multiple users to view the same files simultaneously, but it is structured in a very
special way designed to keep each editor's work safe. When you open up the work of Editor 2:

● You have Read-Only access to Editor 2's work
● You can see or copy what Editor 2 has done.
● You can even edit Editor 2's clips or sequences directly into your own Timeline
● You cannot modify Editor 2's work

EditShare blocks your workstation from creating media folders in any Shared Project Space. As with
Private Files Spaces and Shared Project Spaces, it does not have enough room to create media files.

Folder Name Restrictions
Several folder names are restricted from Shared Spaces. These names are reserved for EditShare use.
Do not name folders with any form of any of the following names (that is, any capitalization, spacing,
hyphens, and so on):

● Statistics
● Group Bins
● Unprotected Bins
● Other Users

Shared Project Space Structure
When a project has been created in a Shared Project Space, it is given a structure that includes the
following five special folders:

● Top-level (root) folder: The top-level folder you see inside a project is your private Space. You
can create new files (Avid Bins, or Final Cut or Adobe Premiere Pro Project Files) in this folder
and add and edit sequences, but nothing stored here is visible to other users.

● Your own user folder: Within your project is a folder named with your own username (for
example, “avid1” or “allan”). Like the top-level folder, you can freely edit, organize, and delete
bins or project files stored in this folder. Unlike the top-level folder, the contents of your user
folder are visible, but not writeable, to other users. Other users can see what you are working
on here, but they cannot modify or delete it.

NOTE:  If you want other users to see bins in a project you have shared, you need to move those bins
into your user folder.

● Other Users folder: The Other Users folder contains one folder for each other user who is a
member of the Shared Project Space. This is where you look when you want to see the bins and
project files that other editors are working on – and it is where they look to see your user
folder. You can freely open files inside the Other Users folder, play back clips and sequences,
and even include them in your own sequences, but you cannot edit them.

● Group Bins folder: The Group Bins folder is a place where all bins or project files are read-only
to all users. You can move bins and project files in and out of the Group Bins folder using the
Project Browser (see Using the Project Browser to Move Files), but while items are located in
this folder, they cannot be modified by anybody. If you want to modify a bin or project file that's
located here, you have to take it out and bring it to your own User Folder, then put it back when
you are finished modifying it.
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Group Bins allow you to organize Avid Bins or Final Cut Pro Projects by subject matter or some
other criteria instead of organizing them by user. You might use this folder to store, for
example, the bins or project files that refer to original captured clips that all users edit into their
sequences, to logged daily rushes, or to common elements to be shared among many editors.
You might also put finished rough cuts and fine cuts here so that everybody knows what's
finished, and where to find it. Group Bins is the place where all editors can look to find items
that are frequently needed by the entire group.

● Unprotected Bins (Avid) or Unprotected Projects (Final Cut): The Unprotected Bins and
Unprotected Projects folders were designed for transferring ownership of bins between editors,
but are no longer the best way to do this. Unprotected folders are readable and writeable by all
editors. You can move a file into the Unprotected folder, and another user can move the file
from the Unprotected folder into his own user folder, where he or she can edit it freely.

WARNING:  Never work with bins or project files that are located in the Unprotected
folder. Always move the file to your own folder first. Otherwise, it is possible that another
editor might have the project file open at the same time, and whichever editor saves the
project last overwrites the changes made by the other editor. In addition, some current
versions of Avid do not allow you to save bins in the Unprotected Bins folder.

EditShare recommends that you do not leave files in the Unprotected folder at all. Use it only as a
temporary location for changing the ownership of a file from one editor to another, or not at all.

The Project Browser now offers a better way to transfer ownership of a bin between editors. As
a result, the use of the Unprotected folder is no longer recommended.
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Using the Project Browser to Move Files
The Project Browser tab in EditShare Connect helps you organize your Shared Projects. It provides an
interface with your project, similar to that provided by Windows Explorer, the macOS Finder, or the Avid
Bins window.

The following illustration shows project browsers with Avid Shared projects (left) and Final Cut Pro
Shared projects (right).

The Project Browser gives you the ability to move bins and project files into and out of folders you do
not normally have access to modify. You cannot move files into or out of other users' folders, or the
Group Bins folder, except by using the Project Browser. After you move bins or files, or if you reverse
the move by clicking Undo Give Away, you might need to click the Refresh button to see the result.

The Project Browser also offers a view of the entire Shared Project similar to the Avid Bins window to
users whose NLE does not include such a view.
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The following table provides a summary of how to move bins or projects files in a project:

Moving bins or projects Procedure

Among folders you created at the top level of the
project or your own user folder.

Click the bin or project and then drag it to
Windows Explorer, the Finder, Avid, or the
Project Browser.

From the top level or your own user folder to
another user’s folder.

Click the bin or project and then drag it
elsewhere in the Project Browser. If you
accidentally drop the file into the wrong folder,
click the Undo button within ten seconds to
move the file back to its original location. This
time limit prevents any loss of work should the
editor to whom you gave the bin begin editing in
it. The receiving editor might, of course, move
the bin back into your folder the same way you
gave it to them.

From another user’s folder to your own user
folder.

By default, you cannot do this. You must get the
other user to move the file into your folder for
you. However, the EditShare Administrator can
give individuals the capability to move files from
another user's folder. If you have been given this
capability, drag and drop in the Project Browser.

WARNING: Use extreme caution when
you use this capability. While this does not
destroy any work being done in the bin at the
time it is moved, the new work is saved in an
identically-named bin in the original editor's
Shared Project Files, creating the potential for
confusion and inconsistency.

Between the top level or your own user folder
and the Group Bins folder.

Drag and drop in the Project Browser.

Between the top level or your own user folder
and the Unprotected Bins/ Unprotected Projects
folder.

Drag and drop in Windows Explorer, the Finder,
Avid, or the Project Browser.

Caution: if another user is working with
the file, you might accidentally cause there to
be multiple copies, or overwrite their work.

Anywhere else. Drag the file to your own user folder first and
then to its desired location.
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Creating a Project Space
To create a Project Space:

1. Open EditShare Connect and log in.
2. Click the Projects tab.

3. Click the New button, then select New Project to create a new Project container within the
Lockable Project.

4. The New Project dialog box opens.
5. Type a name for your project in the text box.
6. Click OK to create the Project.
7. The Project Name displays in the Project Space drop down list.
8. Check that you can save Adobe Premiere Pro projects in your project space. Launch Adobe

Premiere Pro, create a new project, and save it in a location within the Editshare Shared Project
space.

You can optionally make subfolders within the project container to organize your project files, for
example, rough cuts, graphics, and so on.
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Pop-Out Project Browser
You might want to use the pop-out EditShare Project Browser instead of the Project Browser tab built
into EditShare Connect. The advantage of the pop-out browser is that you can resize it to fit nicely onto
your screen among the other NLE windows.

To use the pop-out Project Browser:

1. Start EditShare Connect, and mount the Shared Project Space that contains the project you
intend to work on.

2. Click the Pop out button. The Project Browser opens.

3. Resize the Project Browser to proportions you like, and then create an NLE desktop around the
Browser.

4. To copy project files or entire folders from your local machine to the EditShare Project Space,
select File > Save Project As and navigate to the Shared Project Space where you want the file to
be. A dialog box opens asking if you want to move the files or folders or if you want to copy them.

5. If you need a local copy, navigate to the Shared Project Space from your Finder and find the
files or folders you need.

NOTE:  You cannot drag and drop objects out of the EditShare Project Browser and you cannot
rename a project stored in a Shared Project Space.
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Working from Multiple Shared Project Spaces and Folders
You can mount more than one Shared Project Space and work with more than one Shared Project
folder. The EditShare Project Browser displays the contents of all Shared Project Spaces that are
currently mounted on your workstation. Each Shared Project Space might contain multiple Shared
Project folders. Clicking the Up arrow in the EditShare Project Browser until the display no longer
changes reveals all Shared Project Spaces. Inside the Spaces are the Shared Project folders, each with
its own directory structure, organized for safe and easy Project Sharing.

Lockable Project Spaces
NOTE: This feature is for non-Avid editing applications such as Final Cut Pro and Adobe Premiere Pro.

You can create a lockable Shared Project Space in which all files in a project are read-only (locked) until
a user takes ownership of one. This can provide an easy way to share projects, particularly in smaller
groups where you do not mind other users working on your files.

When you take ownership of a file in a lockable Project Space, you can write to the file (unlocked to you)
but it is locked to all other users. When you are done with that file, you can release it and another user
can take ownership of it and write to it, locking it to all other users, including you.

When you make a new project in a Lockable Project Space, you create a top level Project Folder where
you and your colleagues store the various files that make up the entire Project. Large projects are
broken down into smaller ones so each editor has control over the portion of the project they are
working on. For example, one editor can work on Scene 1 while another editor works on Scene 2. Both
scenes are part of the same movie, but each scene is represented by a separate Adobe Premiere Pro
project file.

When you want to work on a particular project file, you unlock it. This gives you exclusive write access to
that file, and locks it (makes it read-only) for other users. Even though a project file might be locked for
other users, they can still have read-only access to your project file, allowing them to play and review its
contents. Users can also import elements from locked project files into project files they control. The
only thing they cannot do is modify a project file while somebody else has it open for writing.
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Creating a Lockable Project Space
To create a lockable project space you need Administrator-level access. If you do not have
Administrator-level access, ask your Administrator to carry out the following procedure:

1. Open the EditShare Manager in which you want to create a lockable Project Space and click the
Project Spaces tab.

2. Enter a name for the new project.
3. Select Lockable from the Project Type list.
4. Click Add Project Space to System.
5. To add users to your new space, click Add Multiple.
6. The Add Users window opens.
7. Add or remove the users you want to have access to your group by selecting or deselecting the

relevant user.
8. Click OK to update the user list.

For detailed information about creating Project Spaces, see the EditShare Administrator’s Guide.
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Opening a Lockable Project Space
To open a lockable Project Space:

1. Open EditShare Connect and log in.
2. Click the Projects tab.

3. Select your Lockable Project Space from the Project Space drop down list.
4. Click the New button.
5. The New Project dialog box opens:

a. Select New Project.
b. Type the name of your project.
c. Click OK.

NOTE:  You must create a new project in the Lockable Project Space from within EditShare Connect.

6. Populate your project with the project files you want.
7. For an explanation of the file locking icons, see File Locking and Ownership.
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File Locking and Ownership
Lockable Shared Project Spaces are distinguished by the use of padlock icons. In Lockable Shared
Project Spaces, each time you create a new Project, you are defining a new top level folder inside which
you will store all NLE project files that are related to a particular project. All users can see all project
files, but any particular project file can only be open for writing by one user at a time. Files appear as
one of the following:

● locked by another user (red icon)
● available to be unlocked for writing by you (yellow icon)
● currently unlocked by you (green icon)

1. Files that are not in use by anyone display a yellow padlock icon in the Status column. These files
are locked (read-only) but available for any one user to unlock and write to.

2. To open a file for yourself and lock it for everyone else, click its associated yellow padlock icon. The
icon changes to a green unlocked padlock.

3. Files that someone else is using display a red padlock icon and the user’s name in the Owner
column.

4. A folder that has a red outline in red is for administrative use. You cannot write into that folder.
5. You can write into projects represented by unmarked folders, as in the On the Wall folder.

Users cannot delete empty folders in Lockable Shared Project Spaces. The administrator for your
EditShare system can delete folders using the Manage Shared Project Files Space section of the Project
Spaces tab in any EditShare Manager. For more information, see the EditShare Administrator’s Guide.
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Relocking Files on Exit
To relock all unlocked files when you logout of EditShare Connect:

1. Click the Settings tab.

2. Click on the ‘Project Browser’ side tab (it is selected by default).
3. Click the ‘Disown locked files on quit’ box.
4. All files revert to unused (locked, available) status and display the yellow Lock icon to other users.
5. To leave all files you have taken ownership of in their current state, deselect the option.
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Chapter 6: EditShare Limited
Administrator
In general, the EditShare Administrator is responsible for managing EditShare users and Media Spaces.
However, sometimes the Administrator might choose to delegate certain management tasks for
specific Media Spaces to other trusted users. For example, the editor in charge of a certain project
might be given the ability to add users to Media Spaces for that project without needing to involve the
Administrator. In some organizations, this can greatly streamline your workflow.

If you have been designated a Limited Administrator and granted these capabilities, a Limited Admin
tab displays when you log in to EditShare Connect. Click this tab to use the administrative functions the
Administrator has allowed you to use.
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Limited Administrative Functions Overview
As a non-Administrator user, you can perform some or all of the following Limited Administrative
functions through EditShare Connect:

Space Type Available Capabilities

Avid MXF, Managed, Universal ● Protect or Unprotect Media
● Change Read-only Mode
● Change Media Space Quota
● Enter or Leave Maintenance Mode
● Add Users to a Space
● Remove Users from a Space
● Display Space Summary

Avid Style, Unmanaged ● Change Read-only Mode
● Change Media Space Quota
● Add Users to a Space
● Remove Users from a Space
● Display Space Summary

Shared Project ● Add Users to a Space
● Remove Users from a Space
● Take a Bin from Another User

System-wide ● Add Media Space to System
● Add Shared Project Space to System
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Creating Media Spaces
To create a Media Space:

1. With the Limited Admin tab selected, click the Add Space button.
2. The Add Space dialog box opens.

3. Type a name for your Media Space in the Name text field.
4. Select the type of Space you want from the Media Space Type drop down list.
5. From the RAID Array drop down list, select the RAID on which you want to host your Media Space.
6. In the Quota text box, type the quota you want to reserve for the Space.
7. Click the Add button.
8. The newly created Media Space displays in the left hand panel.
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Creating Shared Project Spaces
To create a Shared Project Space:

1. With the Limited Admin tab selected, click the Add Space button.
2. The Add Space dialog box opens.

3. Click on the ‘Add Shared Project Space’ tab to select it.
4. Type a name for your project in the Name field.
5. Select the type of project you require from the Project type drop down list. The options are:

● Avid
● Non-Avid
● Lockable Projects

6. Click the Add button.
7. The newly created Project Space displays in the left hand panel.
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Modifying User Access to Media Spaces
To add users to or remove users from a Media Space:

1. In the left hand pane of EditShare Connect, click on the Media Space to which you want to add users.

2. Click the Modify Membership button on the right.
3. The Modify Membership dialog box opens.
4. In the Add? column, click the box next to the users you want to add to the Media Space.
5. In the Remove? column, click the box next to the users you want to remove from the Media Space.
6. Click Next.
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7. If you are adding a user to a space:

a. Click the Read Only box to prevent that user from writing to or deleting from the space.
b. Click Next.

8. If you are removing a user from a space:
a. Select whether to move that user’s media or project files to the EditShare Trash,

permanently Delete them, or to transfer them to another user.
b. Click Apply.

9. A message box opens to confirm the changes you made.

10. Click the Close button to save your changes.

86



Protecting Users’ Media
To protect a user’s media, or to change their Read-Only status:

1. In the left hand pane of EditShare Connect, click on the Media Space you want to change.

2. Click the Modify Properties button on the right.
3. The Modify Properties dialog box opens.
4. In the Protect? column, click the Read Only box to prevent that user from writing to or deleting

from the space.
5. In the Read Only? column, click the box next to the users you want to have Read Only access to

their media.
6. Click the Modify Properties button to save your changes.
7. Click the Close button ‘X’ to close the Modify Properties dialog box.
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Changing Disk Quota
To change the disk space quota for a Media Space:

1. In the left hand pane of EditShare Connect, click on the Media Space you want to change.
2. Click the Change Quota button.

3. The Change Quota dialog box opens.
4. Type the new value for the Quota. You may append the value with tb or mb to specify Terabytes

(TB) or Megabytes (MB) respectively.
5. Click the Apply button to apply the change.

Maintenance Mode
Entering Maintenance Mode
NOTE: EditShare recommends having all users log out of a space before entering or exiting Maintenance
Mode. This process requires exclusive access to files being modified, deleted, or moved. Other users accessing
files on spaces in Maintenance Mode will not be able to modify, delete, or move files even if they normally
own the files.

To enter Maintenance Mode:

1. In the left hand pane of EditShare Connect, click on the Media Space you want to put into
Maintenance Mode.

2. Click the Enter Maintenance Mode button. This button is grayed out on media space types that
do not support or use Maintenance Mode.
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3. The Maintenance Mode dialog box opens.
4. Select the user you want to assign for Maintenance Mode from the Select User drop down list.
5. Click the Set User button.
6. The Media Space goes into Maintenance Mode.

● The legend and function of the Enter Maintenance Mode button changes to ‘Leave
Maintenance Mode’.

● Users with Limited Administration can see which user has accessed Maintenance Mode.
● The Media Space status displays as in Maintenance Mode, together with the assigned user,

in the Status tab of EditShare Connect.

Leaving Maintenance Mode
To exit Maintenance Mode:

1. Click the Leave Maintenance Mode button.

2. The Remove Maintenance Mode dialog box opens.
3. Select what to do with any files deleted during Maintenance Mode:

● Put into Trash
● Delete Permanently

4. Click the Apply button.
5. The Media Space is taken out of Maintenance Mode. Users may now log in to the Media Space.

89



Administration Summary
The Limited Admin Summary capability allows you to see all information about a Media Space (such as
user membership, read-only status of users, quota, Maintenance Mode status, etc.), even if you have
not been granted permission to change any of these parameters.

The button or control for any parameter that you are not allowed to change is grayed out.
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Chapter 7: Using Avid Applications
The following topics describe aspects of using EditShare with Avid applications:

● Setting up Avid Workstations
● Digitizing (Capturing) Media
● Avid Media Database Files
● Migrating Avid Media and Projects to EditShare

Setting up Avid Workstations
You need to do the following to configure your Avid workstation:

● Use the Avid Launcher. If you are on Windows and not using the Avid Launcher or you are on
Mac and not using Avid Style Spaces, you need to use alldrives to enable Avid to see Avid MXF
spaces. See Enabling Avid Editing Systems to see Avid MXF Media Spaces.

● Ensure that Filter Network Drives Based on Resolution is disabled in Avid. See Disabling the
Filter Network Drives Based on Resolution Option.

● (Windows only) Disable Simple File Sharing. See Disabling Simple File Sharing Option (Windows only).
● Make sure you are using Windows-compatible file names. SeeUsing Windows-Compatible Names.

Disabling the Filter Network Drives Based on Resolution Option
To see network drives, you need to verify an option in the Avid application’s Media Creation dialog box.

Depending on which version of Avid software you are using, Avid might enable Filter Network Drives
Based on Resolution by default each time you create a new project. However, with filtering, the Avid
editing application assumes that any media that is not on your internal “default media creation drive”
has the wrong resolution (for example, that it is 1:1 instead of DV, or the opposite) so it filters out that
drive. To prevent Avid software from filtering like this in the future, you should change your default
preferences so that Filter Network Drives Based on Resolution is automatically deselected every time
you create a project.

NOTE:  For detailed information about the Media Creation dialog box, see the Help for your Avid application.

To deselect Filter Network Drives Based on Resolution and change your default settings:

1. Start your Avid application and open a project.
2. Select Settings > Media Creation. The Media Creation dialog box opens.
3. Click the Drive Filtering & Indexing tab and deselect Filter Network Drives Based on Resolution.
4. Click OK.
5. Select File > Open Settings.
6. Click the Up arrow and navigate to the next level of folders.
7. Double-click the Site Settings folder.
8. Click the Media Creation folder in the Avid Settings folder and drag it into the Site Settings folder.
9. Select File > Save Settings.
10. Filter Network Drives Based on Resolution is deselected each time you start a new project in the

future.
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Disabling Simple File Sharing Option (Windows only)
For proper operation, Avid requires that you disable simple file sharing on your Windows workstation,
whether or not you are using EditShare. With simple file sharing enabled, which is the Windows default
setting, permissions settings on project files (bins, sequences, and so on) and Media Files are set
incorrectly by your Avid editing software.

Incorrect permissions might not affect you immediately if you are working by yourself and storing all
your files locally, but when you copy a project file or media file from one place to another (for example,
when you make a backup of your project file), you might be unable to open the copy even if you move
it back to its original location. Similarly, if two users on your computer log in with individual usernames
and try to access the same project files or media files, they receive instant “Access Violation” warnings.

At this point, even turning off simple file sharing does not solve the problem for those files, because the
permissions are already set incorrectly.

WARNING: When you are working with EditShare, which is designed for multiple users to
share the same media files and project files, having simple file sharing set incorrectly causes major
problems almost immediately.

Disabling Simple File Sharing (Windows XP)
1. Click the Start button and select Settings > Control Panel.
2. Double-click Folder Options. The Folder Options dialog box opens.
3. Click the View tab.

4. Scroll to the bottom of the Advanced Settings list.
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5. Deselect Use simple file sharing (Recommended) and then click OK.

Disabling Simple File Sharing (Windows Vista)
1. Click the Start button, and select Control Panel > Network and Sharing Center. The Network and

Sharing Center window opens.
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2. In the Sharing and Discovery area, click the arrow next to File sharing. The File Sharing area opens.

3. Select Turn off file sharing, and then click Apply. File sharing area is now disabled.
4. Close the Network and Sharing Center window.

Disabling Simple File Sharing (Windows 7)
1. Click the Start button, Select Control Panel > Network and Sharing Center. The Network and

Sharing Center window opens.
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2. In the Change your networking settings area, click Choose Home group and sharing options.
The Change sharing options for different network profiles window opens.

3. Click the check mark next to Home or Work. The Share with other home computers running
Windows 7 window opens.
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4. Click Change advanced sharing settings in the left panel. The Advanced Settings window opens.

5. Select Turn off file and printer sharing, and then click Save Changes.
6. File sharing is disabled. Close the Network and Sharing Center window.
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Disabling Simple File Sharing (Windows 8)
1. Navigate to the Start screen, type “network and sharing center”, and then press Enter. The

Network and Sharing Center window opens.

2. Click ‘Change advanced sharing settings’, and then click Apply.
3. The Advanced Settings window opens. Select Turn off file and printer sharing, and then click

Save Changes.
4. File sharing is disabled.
5. Close the Network and Sharing Center window.

AFP
AFP is the traditional network protocol used by OS X for connecting to other Apple computers over the
network. On OS X 10.8 (Mountain Lion) and earlier, EditShare recommends that editors connect to
EditShare by AFP if possible. AFP should provide the best stream counts and smoothest experience
with Avid on these workstations.

NOTE:  AFP is not compatible with the Edit While Capture feature of the EditShare Flow and Geevs Ingest
Servers. If you work with Edit While Capture, you must use SMB.

Native SMB
EditShare supports the built-in SMB protocol implementation in OS X 10.7 (Lion) and newer, including
workflows that use Avid editing software. With Apple’s improvements to its Native SMB implementation
in OS X 10.10 (Yosemite) and newer, Native SMB access performs well enough to work in video editing
workflows. In older versions of OS X, performance is considerably poorer.
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Considerations for Using AFP: Exporting QuickTime Movies
Avid applications running on OS X can have trouble exporting QuickTime movies to AFP-mounted
Media Spaces. Do not confuse Exporting with rendering effects or consolidating. Exporting refers
specifically to creating a new self-contained QuickTime movie from a clip or sequence. The limitation on
exporting seems to be related to whether or not the application is using legacy 32-bit QuickTime
libraries or newer 64-bit QuickTime libraries.

When you export from Avid Media Composer v6 and v7 and create a movie file larger than 2 GB, if you
click Same as Source in the export settings as shown in the following illustration, the export always
stops at 2 GB (sometimes reported as 2.15 GB in Finder).
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If you are creating a short movie smaller than 2 GB, you can select Same as Source. However, it is really
only appropriate to click Same as Source when all of your material has been captured in a single codec.
If your movie will be larger than 2 GB and/or if you have source material created in many different
codecs, EditShare recommends that you select Custom.

When you select Custom in your export settings, you must configure both the Video and the Sound
format settings. Clicking Settings in the Video area opens up the following configuration screen, where
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you can choose the codec you want for your export, including DNxHD, ProRes, H.264, or other codecs.

You also have to set the Audio format when you export with custom settings. By default, Avid sets the
export to 44 kHz audio, but you might want to keep the audio at 48 kHz to preserve maximum quality.
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Using Windows-Compatible Names
Even if your organization uses nothing but OS X, EditShare requires you to name your files with
Windows-compatible names. In Avid, you need to select the Use Windows Compatible Names option.
For information about where to locate this option, see the Help for your Avid application. In addition,
you should not use non-alphanumeric characters (that is, *?/.-_!#%) in file names.

Digitizing (Capturing) Media
When you digitize (capture) media, you need to direct Avid to put the media into the desired Avid Style
or Avid MXF Media Space on your EditShare server, not on your local hard drive (which no other users
can see) or in the Avid Shared Project Space (which does not have enough room for media). EditShare
blocks your Avid application from creating media folders in any Project File Space.

On Windows workstations, EditShare suggests mapping your most-used Media Space so that it appears
as drive Z. If you connect to more than one Media Space simultaneously – for example, if your project
has more than one Media Space associated with it, such as one for captured media and one for
rendered effects – be careful to put your media onto the correct drive.

On Windows, unless you run Avid Launcher, Avid only shows you the drive letter that you have mapped
to the Media Space and not the full name. If you forget which EditShare Media Space corresponds to
which drive letter (for example, if you’ve captured into Drive Z: and rendered effects into Drive Y:), you
can always check in EditShare Connect to see the full name of your mapped drives.

Selecting EditShare Spaces on OS X
To select an EditShare Shared Project Space in which to save your Avid project when you are working
on an OS X system:

1. Start your Avid editing application.

2. Click the folder icon on the right side of the Select Project dialog box. The Project Directory
dialog box opens.
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3. Select your network volume or select your computer and then navigate to your network volume.
4. Select your mounted Shared Project and then click Open.
5. In the Avid application, select a destination for your media files.
6. EditShare Spaces, including Media Spaces, display automatically in the list of possible drives in

the Media Creation dialog box and the Capture tool.

Managing Avid Media Files
Compared to managing metadata files, managing media files is simpler. You only need to store
captured files in an Avid MXF Media Space for the project.

You should also review the special considerations described in Managing the Avid Media Database.

To manage your media files in your Avid application:

1. Connect to the Media Space you want.
2. (Windows only) Map the Media Space to a drive letter, for example, Z.
3. Select the Media Space in the Avid Capture tool by drive letter (Windows) or by name (OS X).

Managing the Avid Media Database
It is a known Avid issue that the Media Database files created by Avid editing applications are
vulnerable to corruption as they grow larger. When a Media database file gets too large, the Avid
application noticeably slows down, and eventually the database file becomes corrupted.

For this reason, Avid officially recommends storing no more than 5,000 media files in any given storage
volume or Media Space. In fact, Avid applications normally create a new MXF subfolder once you reach
5,000 files in any single folder.

EditShare concurs that all users should follow these guidelines. To help you, EditShare monitors all Avid
Media Spaces and sends the EditShare Administrator a warning email when the number of files in a
folder might be growing too large.

To keep a smaller number of files in each Media Spaces:

● Don’t break tapes into hundreds of master clips – use subclips instead. Many users are
accustomed to a workflow where they log their tapes before capturing, and then capture the
tapes in dozens or hundreds of small clips. Unfortunately, this workflow results in creating
dozens or hundreds of files for each tape – at least three files (one video, two audio) for each
master clip.

To reduce the number of files you create, EditShare recommends NOT logging tapes before you
capture them. Instead, you can capture each entire tape as a single clip. A complete one-hour
DV 25 tape might be captured in just 8 files (6 video plus 2 audio). If the tape has a few
timecode breaks, you might end up with 20 or 30 files. But the number of files should be much
lower than if you capture a tape in hundreds of small master clips.

After capturing an entire tape as one or a few master clips, your loggers or assistant editors can
break down those master clips into an unlimited number of subclips, and give each subclip a
useful name that is visible when you edit the subclip into your Timeline. Creating subclips
doesn’t create any additional media files.
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● Put rendered files in their own Media Space. Creating a separate Media Space for storing
rendered effects further reduces the risk of accumulating too many files. Consider creating a
“Render Space” for each project. This can also avoid a problem some Avid users have observed
where certain types of render files can cause a media database to grow unexpectedly large
(hundreds of megabytes in size) and become easy to corrupt and difficult to rebuild.

Avid has confirmed that this problem has nothing to do with EditShare, and in fact, using
EditShare to keep your rendered files separate from captured media files helps protect you
from this problem. If you become unable to rebuild the media database with rendered files,
you can delete the rendered Media Space and rerender what you need without losing your
captured media files.

Avid Media Database Files
One of the reasons Avid NLE software is so powerful and robust is that Avid programs create a media
database in every media folder on every drive. These databases contain essential information about
each clip in that folder – the tape name or number, the clip name, the media files that make up that
clip, and so on. Even when drive names or letters change, Avid NLEs know exactly which files are where
simply by reading the database in each folder. Avid doesn't need to actually look at the files themselves
once the database has been created.

When working with a local drive, you are largely unaware of the media database files. Every time you
capture or delete a clip, Avid automatically updates the media database at the moment the clip is
captured or deleted.

However, if clips are copied or moved from one drive to another outside of an Avid application (for
instance, if you are combining clips from two drives), when Avid is restarted, all new media files are
detected and scanned and the database files are then updated to reflect the new additions.

If there are only 10 or 20 new clips, scanning the files and updating the database takes just a few
seconds. But if thousands of new clips are added to a drive, scanning can take several minutes. If clips
have been deleted from a media folder outside of the Avid program, when you start the program again,
Avid must rebuild the database from scratch, because it doesn't know which files have disappeared.

Media Databases and Avid MXF Media Spaces
In Avid MXF Media Spaces, each user captures and renders files into his or her own numbered
subfolders of the MXF folder. This design ensures that each folder's media database is always kept in
sync with the media files in that folder, thus avoiding the need for frequent rescanning and updating of
the databases as new files are added by other users.
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Migrating Avid Media and Projects to EditShare
You can migrate your Avid media and projects to EditShare. You should first do the following:

1. Select projects you want to migrate to the EditShare server.
2. Organize the media in terms of the project it belongs to. Keep projects separate that are owned

by different clients, or projects covering different subject matter. This facilitates editors
knowing which Media Spaces to mount, which media can be moved or deleted, and where the
media resides.

3. Decide on a schema: post-production houses might create a Media Space for each job, while a
news facility might organize by dates or subject matter, for example, features, interviews,
headlines, and so on.

4. Create the Media Spaces you need. Make sure that no more than 5000 files go into any
individual numbered folder inside Avid MediaFiles/MXF/.

5. Consolidate or relink the media to EditShare, and migrate the Avid project files to a Shared
Project Space.

NOTE : Consolidating copies only the media actually used in the selected clips and sequences, and
omits media files or parts of media files that are not referred to. If you are transferring a project to
EditShare that you are still actively working on, you might want to relink your files rather than
consolidate them.

NOTE:  If you have existing OMF media you want to transfer to EditShare, EditShare recommends transcoding
it to MXF so you can use the Avid MXF Media Space rather than a Traditional Avid Media Space.

Consolidating Avid Media Using Consolidate/Transcode Tool
To move all and only the media connected to a single Avid project:

1. Start the Avid editing application, and open the project.
2. Select the clip or clips you want.
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3. Select Clip > Consolidate/Transcode. The Consolidate/Transcode dialog box opens. For detailed
information, see “Using the Consolidate Command” in the Avid editing application Help.

4. Select the Consolidate option in the upper left corner.
5. In the Target Drive(s) area, select the relevant Media Spaces.
6. Select Skip media files already on the target drive.
7. Click the Consolidate button in the lower right corner. The Copying Media Files dialog box opens.

8. Select Relink Master clips to media on the target drive, and then click OK.
9. Disconnect the drive from the editing application by doing the following:

● If the drive is internal, rename the Avid MediaFiles folder to Avid MediaFiles.old.
● If the drive is external, unmount it and detach if from the editing application.

10. Check the project for offline media.
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Relinking Avid Media to EditShare
An alternative to using the Consolidate/Transcode tool is to do the following:

1. Navigate to the Avid media in Windows Explorer (Windows) or the Finder (OS X), and copy it to
the Media Space you want on the EditShare server.

2. Start the Avid editing application.
3. Select the clip or clips you want.
4. Select Clip > Relink. The Relink dialog box opens. For detailed information, see the Avid editing

application Help.
5. Select options as described in “Relink Options” in the Help and then click OK.

Migrating Avid Project Files to a Shared Project Space
You can migrate Avid projects to an Avid Shared Project Space on EditShare. Do the following:

1. Make sure your Avid project is in the usual structure, and that you are not using any restricted
names. See Folder Name Restrictions.

Do not use the following words in folder names:

● OMFI
● Avid MediaFiles
● Capture Scratch
● Audio Capture Scratch
● Render Files

In addition, do not use any of the following file name extensions:

.omf, .mxf, .wav, .avi, .mpg, .mov, .aif, .mp3

2. Copy the project to an Avid Shared Project Space.
3. Start EditShare Connect, and click the Avid Management tab.
4. Click Update this Page.
5. In the Share Avid Project area, select the project, and then click Share.
6. The project is now migrated to EditShare.
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Chapter 8: Using Final Cut Pro X
EditShare supports the use of Final Cut Pro X (FCP X) for the storage of media as well as the storage of
Events and Projects. With default EditShare configurations, individual editors can store their own media
in their own Events and Projects on an EditShare server.

To use FCP X with EditShare Shared Storage products, consult the following sections.

● Network Protocols Compatible with FCP X
● Using FCP X 10.1 with EditShare Storage
● Using FCP X 10.0 with EditShare Storage

Network Protocols Compatible with FCP X
EditShare supports using both SMB and AFP with FCP X, and recommends using Unmanaged Media
Spaces to store both media and project files.

FCP X natively supports access to network volumes over SMB. EditShare uniquely provides AFP support
for FCP X as well.

NOTE: If you are using FCP X 10.0.x, see Using FCP X 10.0 with EditShare Storage for details. FCP X 10.0 uses
SAN Volumes for metadata files on networked volumes, while 10.1 uses Library Bundles: these two
approaches are incompatible.

Using FCP X with AFP-mounted Media Spaces
To use FCP X on AFP-mounted EditShare Media Spaces, editors must first enable FCP X support in
EditShare Connect:

1. Open EditShare Connect and log in.
2. Click the Settings tab.
3. Click the Final Cut Pro section.

4. Click the button next to Enable AFP support.
5. Quit EditShare Connect.
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6. Reopen EditShare Connect and log in.

7. You should now see a “Launch FCP X” button next to the server status at the top right of the
EditShare Connect interface.

8. Click “Launch FCP X” to start FCP X with AFP support enabled. FCP X should now be able to
access EditShare Media Spaces mounted via AFP.

Using FCP X 10.1 with EditShare Storage
Final Cut Pro X 10.1 introduces a new project format, the Library Bundle, which changes how FCP X
links to media. FCP X 10.1 now uses hard links in some of its normal operations. Hard links are
designed for local storage and cannot be created on networked storage mounted via SMB and AFP.

Specifically, FCP X 10.1 makes hard links during the conversion process between the old and new FCP X
project formats, and it makes hard links when importing media from the same volume as the project’s
library.

In FCP X 10.1.x, you now have a Library Bundle, which appears in Finder as a file with the .bundle
extension. FCP X 10.1 Events and Projects now reside inside the bundle file. The bundle can’t be opened
in Finder like a normal folder, and only one person can open a bundle at a time.

Managing Projects and Media in FCP X 10.1
In FCP X 10.1, if you copy a media file from one place to another within the same volume–for instance,
from one project’s Events to another project’s Events on the same media space–FCP X will attempt to
create a hard link. As with the project conversion process, this will fail on shared storage.

However, if you copy media from one volume to another, FCP X 10.1 either creates a symbolic link
that's allowed on shared storage, or copies the file.

If you use the Import dialogue in FCP X to import a file or clip, it will follow the default rules you set up
to make a copy or a link. However, dragging media from Finder into FCP X will not follow those rules.

EditShare recommends changing your workflow for storing media files if you’re running FCP X 10.1. You
should keep your shared media in a separate media space from your projects.

For example, if you kept FCP X projects and your QuickTime media on the same Unmanaged media
space, EditShare recommends creating a new Unmanaged space and moving your projects or media to
that new space. Editors will need to mount both spaces–the space containing the project and the space
containing the media–to work on the project.
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Issues Converting FCP X 10.0.x Projects to 10.1
FCP X 10.1 creates hard links to all the media files when converting a project from 10.0.x to 10.1 in
order to avoid duplicating media. Since hard links can’t be generated on shared storage devices, such
as EditShare media spaces, the conversion process fails.

One temporary workaround is to export the media space that contains the project as an NFS volume,
which emulates local storage and supports the hard links required by FCP X 10.1. After mounting the
space via NFS, FCP X is able to update the projects; once finished, you can revert to mounting the space
via SMB (or for some beta users, AFP) to access your FCP X projects.

To convert the space:

1. Switch the space’s protocol to remove resource forks, which will cause problems when
mounting via NFS. For instance, if the space is set to be mounted via SMB, switch the space’s
protocol to AFP via the Modify Media Space section of the appropriate EditShare Manager.

2. Export the space to NFS, then mount it on the workstation. For more information, see the
EditShare Administrator’s Guide.

3. Convert the project using FCP X 10.1.
4. Convert the media space back to an SMB-accessible media space.

After FCP X 10.1 converts the project, you may see an error suggesting the project’s media files need to
be relinked. In limited testing in cooperation with Apple, this error appeared to be false—media files in
the project were online. If you encounter any issues, please contact EditShare Support. Another
workaround is to move the FCP X 10.0 project to local storage before converting it to a 10.1 project.

The converted bundle can then be moved back to the media space. However, if your project has a large
amount of media inside the project directories, all of that media must be moved as well. This may not
be possible on exceptionally large projects or if there’s limited local storage, and may take a long time
to copy over the network.

Once the conversion is complete, FCP X 10.1 may ask whether you want to keep the FCP X 10.0 project
directory. EditShare recommends answering ‘No’ to this prompt, which makes the newly created
bundle a standalone project that can be copied back to shared storage.This process can’t be automated
by the server as FCP X itself must convert the project files. Each project on each media space must be
converted individually.
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Chapter 9: Using Adobe Premiere Pro
EditShare central storage is an excellent solution when you want to store your Adobe Premiere Pro
projects and media in a central location for use by individual editors, or when you want to safely share
the media and projects between multiple editors. In order to have a successful experience using Adobe
Premiere Pro with EditShare, read the following section carefully. It explains the importance of
choosing the right types of Spaces for best compatibility with Adobe Premiere Pro and how you should
configure Adobe Premiere Pro for best operation with shared storage.

Adobe Premiere Pro Workstation Setup
To get the full benefit of EditShare's integration with Adobe Premiere Pro, on each workstation, your
system administrator has installed EditShare Connect. You are required to enter your EditShare
usernames and passwords to log into this EditShare client application.

Editshare Connect allows you to do the following:

● Mount those Spaces on your local workstation.
● Create and manage Shared Projects in the Project Browser section of EditShare Connect.
● See a listing of the Media Spaces and Project Spaces on EditShare central storage you are

authorized to access.
● Change your EditShare password (if enabled by the EditShare Administrator).

To prepare a client workstation for use with Adobe Premiere Pro and EditShare:

1. Install Adobe Premiere Pro, and then apply the latest updates.
2. If necessary, install the latest version of NVIDIA CUDA for your graphics card.
3. Install the EditShare Connect software (administrator level access required).

Media Space Design and Usage
Media Spaces are network shares located on the EditShare Storage server that contain your media
files. There are a number of types of media spaces, each of which have different structures and
permissions. Adobe Premiere Pro can read from and write to both Managed and Unmanaged Media
Spaces. It is important to understand how the rules of these two EditShare Media Space types differ.

In a Managed Space, media files are owned by the user who created them, and are read-only to all
other users. Adobe Premiere Pro plays back media files from a Managed Space perfectly well, even if it
only has read-only access to some or all of them. Another key rule of Managed Spaces pertains to
folders. While all users can write files into any folder in a Managed Space, the moment a folder is no
longer empty, the folder becomes owned by the EditShare Administrator. It is not possible for ordinary
users to rename, move or delete a folder that has content that may belong to that user or others. If you
need to rename or delete folders that are not empty, or delete files that do not belong to you, a
Managed Space can be put into Maintenance Mode by the EditShare Administrator, which gives
temporary administrator privileges to that space to one selected user.

In an Unmanaged Space, there are fewer restrictions: all files are readable and writable by everyone,
allowing anyone to delete or modify any file.
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In addition to these basic rules, you can restrict selected users of Managed and Unmanaged Spaces to
read-only access. All files and folders in that Space are read-only to that user, meaning the user cannot
create, modify, move, or delete any of the files or folders.

Both of these Media Space types are valid for use with Adobe Premiere Pro, and each has its own
advantages and disadvantages, depending on the user workflow. Managed Spaces guard more against
the risk of accidental deletion, while Unmanaged Spaces provide more flexibility for everyone to delete
and organize media files as needed. With Adobe Premiere Pro, EditShare generally recommends using
Managed Spaces for source media files, and Unmanaged Spaces for render files. This provides the best
protection for source media files with the flexibility to clean up render files, which can be recreated
with relative ease, if necessary.

Sometimes you might want to use Adobe Premiere Pro with EditShare Avid Style Media Spaces. Avid
Style Spaces have similar rules to Unmanaged Spaces, except they emulate native Avid storage when
connected to Avid NLE applications. As a rule, you should probably avoid configuring Adobe Premiere
Pro to write to Avid Style Media Spaces.

However, if your workflow includes both Avid and Adobe Premiere Pro editors, you can export an AAF
from any Avid sequence that has its media on an Avid Style space and then import it into Adobe
Premiere Pro. The sequence and media should link up.

NOTE: This only works with MXF files in specific codecs such as DV25, DVC Pro, DV50, DVC Pro HD, XDCAM-HD,
and AVC-intra. For example, DnxHD is not currently supported with this workflow.

You should always avoid using Avid MXF Media Spaces with Adobe Premiere Pro, as these are designed
specifically for editing Avid media with Avid NLE applications.

The Editshare storage should be divided into a number of Managed or Unmanaged Media Spaces using
the EditShare Manager tools provided in the EditShare Workflow Director. Usually you divide media
into separate Media Spaces for each project, making it easier to assign user permissions and manage
your media when projects are complete.

Considerations for Media Sharing
You can share media and projects between multiple Adobe Premiere Pro workstations running OS X or
between multiple workstations running Windows. In general, avoid sharing between Windows and Mac
workstations. There are currently several limitations with shared projects when you run multiple
Windows clients, or a mix of Mac and Windows clients, as follows:

● If you work with the same projects on multiple Windows clients, each client must assign the
same drive letter for a given Media Space. Adobe Premiere Pro and Windows are sensitive to
the exact path name defining the media file location. If the drives are mounted on different
drive letters, the paths are inconsistent and users have to relink your media.

To assist you in keeping drive letters consistent, EditShare Connect for Windows remembers
the drive letters you assign to Media Spaces. If you assign drive letters correctly the first time,
each subsequent time you sign into EditShare Connect, your Media Spaces remount correctly.

In a future release, EditShare will include a Projects Profile feature, allowing you to mount the
same Media Spaces using consistent drive letters.
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● If you open the same Adobe Premiere Pro project on both OS X and Windows clients, you need
to relink the media files each time you open them, as the paths to the media are different. On
Windows, the path to a file might be something like Z:\Clips\Day1\firstshot.mov whereas on
Mac the path would be /Volumes/SpaceName_1/Clips/Day1/firstshot.mov. Adobe Premiere Pro
on Windows and Mac would not see these paths as the same.

● Render Files are not cross-platform compatible. If you open the same Adobe Premiere Pro
project on OS X and Windows workstations, Adobe Premiere Pro discards the files and you have
to re-render them. This is a current Adobe Premiere Pro restriction.

Lockable Project Spaces
EditShare Lockable Project Spaces allow you to safely store and share multiple Adobe Premiere Pro
project files in a central location that can be accessed and written to by other users at the same time. In
this workflow, Adobe Premiere Pro project files are not stored in the same place as media files and
render files, but are stored separately in an EditShare Lockable Project Space where EditShare rules
ensure each project file can only be opened for writing by one user at a time.

You can also use the Adobe Premiere Pro project browser to collaborate with other users, and lock
project files from other Creative Suite applications such as Adobe After Effects.

See Lockable Project Spaces.

Creating a Project Space
You must make a new project container in a lockable space before you can save Adobe Premiere Pro
Project files in it. See Creating a Project Space.

Viewing Projects in EditShare Connect
You can view your Adobe Premiere Pro projects in the EditShare Connect Project Browser. Open the
project folder to see the projects and the padlock icons.
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Each Adobe Premiere Pro project has one of three colored padlock icons next to it, indicating the
project’s status, as follows:

● Yellow: Neutral state, no users have the project open in read-write mode.
● Green: You have the project locked for read-write access.
● Red: Locked for write by another user, with an indication of the name of the user that has it

locked.

When you double-click a locked project, you can open it with read-only privileges. You cannot save the
project, but can view content, play sequences, and so on.

After you finish editing a project, you can save it, and then click the green lock icon once to return it to a
neutral state, indicated by a yellow padlock icon. Another user can now open the project with
read-write privileges by double clicking on it.

Adobe Premiere Pro Setup
Setting Media Space Locations
For every new Adobe Premiere Pro project you make, you must set the Media Space location(s) of all
media and render files, and set a number of other options. Do the following:

1. Open Adobe Premiere Pro. In the Welcome screen that opens, click New Project. The New
Project Dialog box opens.

2. In the General tab, make any changes to settings for your project as required.
3. Click the Scratch Disks tab.
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4. Set the locations for:
a. Captured Video
b. Captured Audio
c. Video Previews
d. Audio Previews

5. All media types default to Same as Project. Depending on your workflow requirement, you
should follow one of the procedures described in Storing Projects and Media Separately
(Recommended) and Storing Project and Media Files Together.

NOTE: If you need to adjust the media file scratch disk locations for an existing project, select Edit >
Preferences > Media.

Storing Projects and Media Separately (Recommended)
For the best and safest collaborative workflow, EditShare recommends that you store your Adobe
Premiere Pro projects in a Lockable Project Space. You must adjust the Scratch Disk media locations to
point to the appropriate Media Spaces for each new Adobe Premiere Pro Project that you make.

NOTE: Shared Project Spaces cannot be used for media file storage. If you store Adobe Premiere Pro projects
in a lockable Project Space, you cannot leave the default setting Same as Project for Scratch Disk media file
locations. You encounter problems if you try to capture or render media files to a Project Space location.

For the best combination of flexibility and protection in this case, EditShare recommends the following
Scratch Disk setup.

● Captured Video and Audio: Managed Media Space, generally one per project
● Previews and Audio Previews: Unmanaged Media Space, generally one per project
● Project Auto Save: On each workstation's local drive, or an Unmanaged Space

Make sure you are logged into EditShare Connect. For each Scratch Disk type, navigate to the
appropriate Media Space path.

When you have completed the Scratch Disk selections, save your Adobe Premiere Pro Project to the
appropriate Shared Project space path. Once saved, your project shows up in the EditShare Project
Browser. The user who created it sees a green lock next to his or her project, while other users see a
red lock with the owner’s user name alongside.

Storing Project and Media Files Together
If you do not wish to collaborate on Adobe Premiere Pro projects with other editors, and you are not
using Lockable Project Spaces, you can store your Adobe Premiere Pro project file in a Managed or
Unmanaged Media Space, and you can leave the media locations at the default setting Same as Project.
The default settings for scratch disks within Adobe Premiere Pro expect that all media files, graphics,
audio and renders be kept in the same folder or Media Space as the project. This has the advantage that
separate render Media Spaces do not have to be set up, as is common with Avid based installations.
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Audio Settings
You might want to switch off audio peak generation for projects that contain a lot of audio, otherwise
they take a long time to open.

In Premiere Pro, Select Edit > Preferences > Audio > Turn off Automatic Peak File Generation.
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Appendix A: Traditional Media Spaces
Traditional Media Spaces were the only types of Media Spaces available on the original EditShare
systems. Traditional Media Spaces are now obsolete and it is no longer possible to create new
Traditional Media Spaces. If your system has been upgraded over the years and it still has some
Traditional Media Spaces, you should read this chapter for information about how they work.

Overview
In a Traditional Media Space, you have your own view of each Media Space. When you add files to a
Traditional Media Space (by capturing or rendering, for instance), the files are not initially visible to other
users. In order to make the new files visible to others, you must explicitly Share them, and then each
other user must Refresh his or her view of the Media Space to see the new files that have been added.

NOTE: The EditShare guides use the capitalized terms Share and Refresh specifically to refer to the actions of
making files you have stored in a Media Space available to others, and of viewing files recently Shared. When
the more common everyday uses of the words share and refresh are intended, the terms are not capitalized.

Traditional Media Spaces offer an Unshare function to greatly simplify the process of organizing or
deleting Shared media.

The following table describes the features of Traditional Media Spaces.

Feature Description

Supported NLE Limited support for all NLEs

Network Protocol ● Avid, Adobe Premiere Pro: SMB only
● Final Cut Pro, Other NLEs: SMB or AFP

Access Control Users must be added to the Media Space to have access to the
Public option.

User Operations ● Share
● Refresh

Administrator Operations ● Unshare/Reshare
● Resolve conflicts

Contents (Avid) ● OMFI MediaFiles
● Avid MediaFiles
● Miscellaneous

Contents (Final Cut Pro) ● Capture Scratch
● Render Files
● Audio Capture Scratch
● Audio Render Files
● Waveform Cache
● Thumbnail Cache Files
● Miscellaneous
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Contents (Adobe Premiere Pro) ● Adobe Premiere Pro Preview Files
● Capture
● Conformed Audio Files
● Miscellaneous

Contents (Other NLEs) ● Shared Media
● Miscellaneous

The Share and Refresh system is how Traditional Media Spaces protect shared media files from being
mistakenly or maliciously erased. When you Share a media file, it is moved to a protected area that
cannot be directly accessed or modified by any user. In your private view of the Media Space, the file is
replaced with a shortcut or alias that points to the place where the file was just moved. You continue to
see the file, but you cannot modify it. When other users Refresh, they get their own shortcut to the
same common file.

For Avid users particularly, this Share and Refresh system prevents Avid applications from being
surprised by the sudden appearance and disappearance of new media files, which can cause Avid NLEs
to scan the new files to update their media databases.

Sharing and Refreshing must be performed each time new clips or rendered files are added to a
Traditional Media Space in order to make the new files available to other users and protect them from
accidental deletion. If you desire it, Sharing and Refreshing can be done automatically at an interval set
by the EditShare Administrator. Automatic Sharing and Refreshing is not always appropriate, however.
See Manually Sharing and Refreshing Media Spaces for instructions for manually Sharing files, and for
configuring Automatic Sharing.

Once files in a Traditional Media Space have been Shared, some restrictions are placed on what you
can do with them in order to prevent deleting or modifying them in a way that could be harmful to
other users. Before you share files, you can directly modify them or even delete them. For instance,
you might want to do the following:

● Change the name of a file.
● Modify the tape or reel name as recorded in the metadata embedded in the media file.
● Recapture a file to change its color correction or aspect ratio.

You should make these changes before you Share the file. If you need to modify a file stored in a Media
Space after it has been Shared, see Modifying Files in Traditional Media Spaces.

NOTE: In many cases, your non-linear editing system or graphics application allows you to move or to modify
files that have already been Shared. However, since you only modify your own shortcut to the file, and not the
file itself, these changes are not seen by other users. Such changes do not persist even in your own view of the
Media Space, and in some cases can cause you or others to be unable to properly Share or Refresh those files.
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Editors – Traditional Spaces Workflow
EditShare provides limited support for Traditional Avid, FCP, and other NLE Media Spaces - these were
Spaces in which you had to Share and Refresh in order for editors to see each others’ media files. If
your v7 EditShare system includes any such Traditional Spaces - for instance, you might have upgraded
from EditShare 4 or earlier - you can continue to manage your Traditional Spaces with EditShare
Manager. You can add and remove users from the Spaces, set quotas, Share and Refresh, and so on.
However, you can no longer create any new Traditional Media Spaces.

If you are working with EditShare for the first time, or beginning a new project on a system that already
has some Traditional Spaces, you only have the option of using newer types of Media Spaces – Avid
Style, Avid MXF, Managed, Unmanaged, and Universal.

Miscellaneous Folder
Within each Traditional Media Space, EditShare creates a Miscellaneous folder in addition to the folders
needed for the editing application. In older versions of EditShare, this folder was sometimes used to
store files such as animations, photographs, mattes, and music files that would later be imported into or
referenced by an editing application. However, it is now simpler to use a Managed or Unmanaged Media
Space for such files. As such, EditShare recommends not using the Miscellaneous folder on new systems.

Any files stored in the Miscellaneous folder of a Traditional Media Space are treated just like other
media files stored in the other folders in the Media Space. They can be Shared and Refreshed. They
must not be modified or deleted after being Shared. When the Media Space is deleted, all of the files in
its Miscellaneous folder are deleted.

EditShare Shares only files that are located within the specific folders for your editing application, plus
the Miscellaneous folder.

NLE Specific Folder

Avid Media files must be in OMFI MediaFiles or in Avid MediaFiles folders (which
Avid automatically does).

Final Cut Pro Files must be in one of the standard Final Cut Pro folders: Capture Scratch,
Audio Capture Scratch, and so on.

Adobe Premiere Pro Files must be in one of the standard media folders: Capture, Conformed
Audio, Video Render, and Audio Render.

Other NLEs Files must be in the Shared Media folder.

Place anything else you want to share in the Miscellaneous folder. If you put files anyplace else in the
Media Space, they are not Shared and cannot be seen by other editors.
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Capture Locations
With a Traditional OtherNLE Media Space, EditShare Manager creates two folders inside that Space. It’s
important to put appropriate files into the appropriate folders.

You must put all your media files into the Shared Media folder. This includes captured video, rendered
files, waveform files, thumbnail files, and so on. You should put graphics files, photos, mattes, and so
on in the Miscellaneous folder.

Folder Contents

Shared Media folder Captured video, rendered files, waveform files, thumbnail files, and so on.

Miscellaneous folder Graphics files, photos, mattes, and so on.

Only files inside these two directories are shared. Any files outside these folders are only accessible to
a single user (the one who created the file or put it there).

Modifying Files in Traditional Media Spaces
While it is often possible to modify files in a Traditional Media Space, especially in the Miscellaneous
folder, doing so might not have the results you expect.

For example, suppose you have created a graphic called “Opening Title,” put it into the Miscellaneous
folder as a TIFF or JPG or Photoshop file, and Shared it so others can see it. Then later, your executive
producer decides you need to change the color of text in the title graphic. It would be tempting to
simply open up the file, change the color, and save the title again with the changes. This will not have
the results you want.

If the file has already been Shared, then there is a very good chance (depending on the architecture of
the program used to edit the file) that a new file will end up getting saved in your own “private view” of
the Miscellaneous folder within that Media Space. This makes that file available to you, but the original
version of the file remains in the Miscellaneous folder within the “public view” of the Media Space,
available to everyone else. If you then try to Share your new file so that others can see the changes you
made, EditShare does not automatically replace the old file in the public view with the modified file
from your private view. The whole idea of EditShare's Share and Refresh system, after all, is to protect
shared files from just this sort of unilateral modification.

If you really do need to modify a file that has already been Shared, you can do one of the following:

● Use your NLE or other application to modify the original file and save it, creating a name
conflict. The original version remains in the public view of the Media Space, and your modified
version exists only in your private view. To get the modified file to replace the original file in the
public Space, have your EditShare Administrator resolve the conflict, following the instructions
in the EditShare Administrator's Guide. This describes the procedure that allows the
Administrator to replace the original file with the modified one.

● Make a copy of the Shared file in a different location, such as a local hard drive or a part of the
Media Space outside of the Shared folders. Then delete the original file, following the
procedure described in Deleting and Organizing Media by Unsharing. Then you can modify the
copy of the original file, copy the modified file back to its original location in the Media Space,
and Share it. After other users subsequently Refresh the Media Space, they and their
applications see the modified file instead of the original one.
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● When you modify the file, select File > Save As (instead of Save) to save your changed file with a
new name. This creates a new file, which you can then Share like any other new file. When
other editors Refresh the Media Space, they see both versions of the file and can tell their NLE
or other applications to use the new version instead of the old version.

NOTE: Consider using a Managed or Unmanaged Media Space for storing any file that is likely to need modifying.

Sharing and Refreshing Media Spaces
The key to safely and correctly sharing media files in Traditional Media Spaces is using the Share and
Refresh functions. When you create new files in a Media Space – perhaps by capturing media from a
tape – the files are not made available to other users until you Share the Media Space. In order to see
the new files, other editors must Refresh their own views of the Media Space.

About Share and Refresh
Sharing and Refreshing can be done automatically, manually by editors, or a combination of both.
Manual Sharing and Refreshing gives editors total control over exactly when these functions occur.
Automatic Sharing and Refreshing is available as an option to simplify these procedures in some cases
for editors who do not want to manage them manually. Administrators have the ability to enable,
require, or disable this feature for each user and or Media Space on the system. You can work either
way, or switch back and forth as you perform different sorts of tasks. This section provides instructions
for both workflows.

Before you Share media, you are able to delete it from within your editing application as if it were
stored locally on your own workstation. For example, if you start digitizing some clips and decide you
want to delete them, you actually delete them from the EditShare server if you delete them from your
bin.

However, after you have Shared the media, your Media Files effectively become read-only to you. You
can access them, but you can't delete them; it is now assumed that the media might be important to
other users. Your editing application “thinks” that it can delete shared Media Files, but if you delete
Shared media either through your editing application or through a file manager on your desktop, you
are taking away your own access to that media. The files go offline, but they are not really deleted from
the EditShare Server. If you simply Refresh your Media Space again, you get all the deleted Media Files
back again.

To truly delete Media Files, you must follow a specific procedure as discussed in Deleting and
Organizing Media by Unsharing.
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Manually Sharing and Refreshing Media Spaces
You can share or refresh an individual Media Space or multiple Media Spaces at the same time. You do not
need to Share and Refresh the same set of Media Spaces. To manually share or refresh a Media Space:

1. (Avid only) Turn off your Avid editing application before you Refresh to avoid freezing or
interrupting critical editing tasks (particularly digital cut and render).

2. Select the Media Spaces you want to Share or Refresh by selecting that option in the two
right-most columns of EditShare Connect.

3. Do one of the following:
● For a single Media Space, click the Now button in the Share or Refresh column of the

Media Space.
● For multiple Media Spaces, click the Share Checked Media Spaces or Refresh Checked

Media Spaces button in the Share Management area at the bottom left of the window.

● To Share or Refresh all Spaces, select Manual Share or Manual Refresh.
4. A message opens in the status box indicating how many files were Shared, Refreshed, or found

in conflict.
5. Check the status bar to make sure the operation completed successfully.
6. If files were found in conflict, see your EditShare Administrator.

121



About Automatic Share and Refresh
If your EditShare Administrator allows it, you can set your Media Spaces to automatically Share or
Refresh periodically. The EditShare Administrator can also configure your Media Spaces to Share or
Refresh automatically, but not give you control.

The EditShare Administrator sets the length of time that elapses between each Auto Share or Auto
Refresh event. These times can be different for different Media Spaces.

Automatic Sharing works exactly like manual sharing, with the following exceptions:

● Files in the Miscellaneous folder are not automatically Shared. This helps protect you from
accidentally Sharing files that are not yet ready to be Shared. For example, you might create a
Photoshop file in the Miscellaneous folder, intending to create content in it once and then save
it (and not modify it again). You would not want the file to be automatically Shared before you
were finished creating it, because then you would not be able to modify it.

● Files are not automatically Shared if they have been modified very recently or are smaller than
100 kB in size. This helps prevent Sharing media files that are still in the process of being
captured.

Automatic Refreshing works exactly like manual Refreshing.

WARNING: If you are working with Avid NLEs, EditShare strongly advises you not to enable
Automatic Refresh for your Media Spaces. Automatic Refresh interrupts your work whenever it
occurs, and worse, it can result in corruption of project files if your system ever Refreshes at the
same time you are capturing or rendering files. EditShare only makes Automatic Refresh available for
Avid Media Spaces in case your facility has certain non-Avid machines or users that also need to see
Avid media files (such as Graphics artists or encoding machines) and for some reason those users or
machines cannot use Manual Refresh. Most likely, your EditShare Administrator will disable Auto
Refresh for any Avid Media Spaces, except for users or machines that can use the feature safely.

If the Administrator allows it, you can use EditShare Connect to specify, for each Media Space to which
you have access, whether it automatically Shares, Refreshes, Shares and Refreshes, or does none of
those. (In some environments, the Administrator might not allow you to change this setting.)

Automatically Sharing and Refreshing
To automatically share and refresh your media spaces:

1. Click the Automatic list for the Media Space you want to control.

2. Select one of the following:
● Disabled: The Media Space does not automatically Share or Refresh.
● Share: The Media Space automatically Shares on the schedule established by the

Administrator, but it does not Refresh.
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● Refresh: The Media Space automatically Refreshes on the schedule established by the
Administrator, but it does not Share.

● Share then Refresh: The Media Space automatically Shares on the schedule established by
the Administrator, and then Refreshes.

3. A message opens in the EditShare status box confirming the change.
4. You can still Share and Refresh manually whenever you want.

Administrator Share and Refresh
The EditShare Administrator can Share and Refresh. This should not be considered an everyday
workflow in most organizations, but might be useful in certain circumstances as follows:

● If an editor forgot to Share captured media before leaving for the day, the Administrator can
Share the media.

● In a school setting, the Administrator might be setting up an editing environment for a
classroom and want to Refresh a lot of media into a Media Space for a large number of
students before they arrive.

● In a rental facility, individual editors renting editing bays might not be familiar with EditShare,
so the Administrator might Share and Refresh for them.

See the EditShare Administrator’s Guide for the procedure for an Administrator to Share and Refresh a
Media Space.

Deleting and Organizing Media by Unsharing
As mentioned in Modifying Files in Traditional Media Spaces, once files stored in a Traditional Media
Space have been Shared, you cannot directly move, rename, delete, or modify the files. If you try to do
so, you only affect the shortcuts to the media files, not the files themselves.

The EditShare Administrator (or a designated user) can Unshare your Traditional Media Space. This
causes all previously Shared files to become owned by you, just as if you captured them and had not
yet Shared them. Unsharing allows you to freely move, rename, delete, or modify such files. Other
users do not see the changes immediately (unlike Maintenance Mode for Avid MXF and Managed
Media Spaces). Before Resharing the media, the Administrator has an opportunity to reject changes
that you made. Only when the change is accepted by the Administrator do other users see those
changes.

During the time a Traditional Media Space is Unshared, no users can Share or Refresh the Media Space
until the maintenance is complete and the EditShare Administrator (or other user granted the
capability) Reshares the Media Space or rejects the changes.

It is generally best, if possible, to have all users disconnect from the Media Space before the
Administrator Reshares an Unshared Media Space. If any users remain connected when the Media
Space is Reshared, you might notice the following effects:

● Media files might temporarily go offline while the changes made in Unshare mode are
incorporated into other users’ views. This happens even if very few files were actually changed,
and lasts longer for Media Spaces with more files in them.

● For Traditional Resharing, the Media Space causes the media files to be Refreshed in each
user's view, but does NOT automatically update the Avid media databases. It is recommended,
after Resharing a Traditional Avid Media Space, that you copy the media database from the
user who did the maintenance to all other users.
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● If you have a file open that was deleted in Unshare mode (that is, if you are playing the media
from it) when the Media Space is Reshared, the file might not be properly deleted. Consider
further the following:
○ If the Media Space is mounted using SMB: The file should be deleted once it is closed (that

is, after you stop playing it), but this is not completely reliable.
○ If the Media Space is mounted using AFP: The file is not deleted and no warning is given to

the maintenance user. It appears that the file was deleted, but it is still present.

All of these problems can be avoided by simply making sure all users are disconnected from the Media
Space before Resharing it.

When Resharing, the Administrator (or other user granted the capability) can send to the EditShare
Trash all files that were deleted while the Media Space was Unshared. If it is later discovered that some
files were deleted that should not have been, it is possible to restore them from the Trash. See the
EditShare Administrator's Guide for information about restoring deleted files.

Managing File Names
Under some uncommon circumstances, Avid might create media files whose names begin with a dot
(period). Such files are not Shared and Refreshed, so it is important to ensure that Avid does not create
media files with such names.

One rule of thumb to prevent such files from getting created is to not create sequences whose names
begin with a dot. If you ever render such a sequence, the render file is normally given a name starting
with a dot.

Using Traditional Adobe Premiere Pro Media
Spaces
If you are setting up a new EditShare system, EditShare strongly recommends that you use Managed
Media Spaces for your Adobe Premiere Pro media. While Traditional Adobe Premiere Pro Media Spaces
continue to work well, Managed Media Spaces have significant advantages. See Managed Media Spaces
for more information about Managed Media Spaces.

By default, if you tell Adobe Premiere Pro to put media on a specific drive, for example, the D: drive,
Adobe Premiere Pro puts your media in the folders shown in the following table.

Folder Description

D: Drive/ Captured audio/video files (.avi) don't usually go into their own
folder; they go onto the drive you designate.

/Conformed Audio Files Conformed audio files (.cfa) that are created for each clip you
capture.

/Adobe Premiere Pro Render Files Audio and video render files.

EditShare makes one very important change to the default for Traditional Media Spaces. It is crucial
that you follow the workflow procedure described here and in Setting up Scratch Disks and Naming
Clips During Capture, or else sharing media files does not work properly.
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When you set up a Traditional Adobe Premiere Pro Media Space on EditShare, EditShare automatically
creates the following folders for that project.

● /Capture
● /Conformed Audio Files
● /Adobe Premiere Pro Render Files
● /Miscellaneous

Setting up Scratch Disks
You must place all captured video files in the /Capture folder. This is different from how Adobe
Premiere Pro usually works. If you do not put the video files in the /Capture folder, the video files
cannot be Shared when you tell EditShare to Share them.

When you set the Scratch Disk locations in Adobe Premiere Pro, assuming your EditShare Media Space
is mapped as the Z: drive on your Windows system, your capture locations must look like the following:

(Note that the Z: drive is just used as an example here. Your Media Space could be mapped to any
other drive letter.)

Drive Contents

Z:/Capture Capture Files

Z:/ Conformed Audio Files

Z:/ Video Render Files

Z:/ Audio Render Files

Do not specify Z:/Conformed Audio Files as the location for the .cfa files. If you do, Adobe Premiere Pro
creates another Conformed Audio Files folder inside the one created by EditShare.

Do not specify Z:/ AudioRender Files or Z:/Video Render Files as the location for the render files. If you
do, Adobe Premiere Pro creates a new Render Files folder inside the ones created by EditShare.

NOTE: These considerations do not apply if you use a Managed Media Space for your Adobe Premiere Pro
files. In a Managed Media Space, you can create any folder structure that suits your workflow.
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Naming Clips During Capture
Adobe Premiere Pro allows you to name your clips anything you choose. That’s helpful for creating
descriptive names that clearly identify the clips, but it can be problematic in an environment where
clips are shared; it's entirely possible for two users to create clips with the same name. This wouldn't
matter if the two clips belonged to separate projects. But it would create a conflict if the two clips
belonged to the same Media Space.

When two or more editors are capturing clips on the same project, it’s a good idea to include some
unique characters (like the editor's username or initials) in all clip names.

If you choose not to follow this naming technique, you should at least Share and Refresh frequently.
Enabling frequent automatic Sharing and Refreshing can help with this. As long as Editor A is seeing all
of the clips that have been created by Editors B and C, if a clip name already exists and it has been
shared, Adobe Premiere Pro will not let Editor A create a clip by the same name.

Media Databases and Traditional Avid Media
Spaces
If you are not capturing media using the older Avid OMF format, EditShare recommends that you use
EditShare’s Avid MXF Media Spaces. In this case, you can skip the rest of this section.

For Traditional Avid Media Spaces, media database management is more complex. Each editor who is a
member of a Traditional Avid Media Space has his or her own media database files for each media
folder in that Media Space. That is, there are multiple copies of each media database for each media
folder – one for each user.

Having independent databases for each user allows editors to freely add new clips and render files to a
Media Space without affecting the work of other editors. When you create or render new clips, your
media database is automatically updated by Avid to reflect the new clips.

However, when you Share the new clips with other editors, and those editors Refresh their view of the
Media Space, the other editors’ Avid applications must update their databases to reflect the changes.

If you see only a few new clips when Refreshing, it takes just a few seconds for the files to get scanned
and for your database to get updated. However, if hundreds or thousands of new clips appear when
Refreshing – if, for example, several assistant editors have been capturing clips overnight – it can take
several minutes for your Avid to scan all the files and update its database. If multiple editors Refresh
their Media Space at the same time, the scanning can take longer because everyone’s Avid is
simultaneously inspecting all these new clips and updating their own databases.

Similarly, if just one media clip is deleted, when the Space is Unshared the database files of all other
editors are rebuilt from scratch to take into account the files that are now missing.

To reduce the amount of time spent rebuilding media database files, EditShare allows users to copy
Avid media database files in a Traditional Media Space from one user to another, avoiding the need for
each user's workstation to rebuild its media database separately.

When you are copying a media database file from another user, the safest procedure is for you to shut
down your Avid program. If you need to continue working while the copying takes place, it is essential
that you unmount the Media Space whose database will be updated before it receives the database
copy. When the copying is completed, you can remount the Media Space by selecting File > Mount All in
the Avid application.
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Editors can copy media database files using EditShare Connect, while Administrators can do it using
EditShare Manager. Media database files are never copied automatically, regardless of your automatic
Share and Refresh settings.

Limited Administration Capabilities on Traditional
Spaces
For details on using Limited Administration tools, see Chapter 6: EditShare Limited Administrator.

Type of Space Function Additional Options

All Traditional Media Spaces Share Media (for user) User for whom to Share (select one or
more).

Refresh Media (for user) User for who to Refresh (select one or
more).

Unshare Media User to take control of Media Space.

Reshare Media Accept or Reject changes.
Move Media to Trash Instead of Deleting.
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